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License Agreement 
 
This Agreement is your license to use the copyrighted software program and documentation that comprise 
JREC/R, subject to the limitations explained below. This right to use JREC/R is granted to you in 
consideration of payment of the license fee and upon condition that you accept the terms of this license. 
YOUR USE OF THE JREC/R software, BY INSTALLING IT O N A COMPUTER OR OTHERWISE, 
INDICATES YOUR ACCEPTANCE OF ALL THE TERMS OF THIS LICENSE. 
 
THIS TRANSACTION IS NOT THE SALE OF A SOFTWARE PROD UCT, BUT A LICENSE 
AGREEMENT. THE CD-ROM DISCS AND PROGRAM DOCUMENTATI ON ARE FURNISHED TO 
MAKE JREC/R  AVAILABLE FOR YOUR USE AND REMAIN THE PROPERTY OF J.E.I. 
 
IF YOU DO NOT AGREE WITH ANY PART OF THIS LICENSE, DO NOT USE JREC/R .  RETURN 
ALL COPIES OF THE JREC/R (DVRS) SOFTWARE, THE CD-ROM DISCS AND ALL RELATED 
MATERIALS AND DOCUMENTATION WITHIN THIRTY (30) DAYS  OF RECEIPT TO J.E.I., AND 
THE ENTIRE LICENSE FEE WILL BE REFUNDED TO YOU. 
 
LICENSE TERMS AND CONDITIONS 
 
GRANT OF LICENSE 
J.E.I. grants you, the end-user, a nonexclusive, nontransferable license to use the software program and 
associated documentation contained on the original discs (collectively, the “System”), in accordance with 
the terms of this Agreement. 
 
YOUR USE OF THE SYSTEM 
The information contained in the System is licensed for your personal use and may not be resold or 
otherwise provided to others except as noted under the heading DISTRIBUTION GRANT. If you are a 
business or institution, personal use includes use of the information for in-house operational purposes.  You 
may not transfer any of your rights under this Agreement. 
 
Your right to use the System is limited to use on a single computer consisting of one central processing unit 
equipped with a CD-ROM drive, one keyboard and one display screen. Network use of any kind is not 
authorized. You may transfer the System from one computer to another, as long as you erase all elements 
of the System from the old computer before loading it onto the new one. 
 
You have no right to modify the System in any way, incorporate it into a compilation, reproduce it or 
create any derivative work. You may not reverse assemble, reverse engineer or decompile the System, or 
otherwise obtain access to the source code. 
 
You agree to use the System in accordance with local, state and federal laws. 
 
COPY LIMITATIONS 
You have the right to load elements of the System onto the hard disk of your computer, to load elements of 
the System into RAM and the central processing unit of your computer as required during normal 
operation of the System and, using the System, to retrieve and display the data on a single screen.  
 
OWNERSHIP 
The software is a proprietary product of J.E.I. or its Licensors and is protected under US copyright law 
and international treaty provisions. All copies of the software made by you shall contain J.E.I.’s copyright 
notices. All intellectual property rights in and to the software are retained by J.E.I. or its Licensors. 
 
 
 



WARRANTIES, DISCLAIMER 
Limited Warranty on Media. J.E.I. warrants, for a p eriod of sixty (60) days from delivery (the “Warranty 
Period”), that the discs on which the System is initially furnished shall be free, in normal use, from defects 
in material and workmanship. If, during the Warrant y Period, a defect in the discs appears, you may 
return the discs and associated documentation to J.E.I. for either replacement or, if so elected by J.E.I., 
refund of your purchase price.  
 
Disclaimer of Warranty on Software. Neither J.E.I. nor its Licensors warrants the use of the software will 
meet your needs or that its use will be uninterrupted or error free. EXCEPT FOR THE WARRANTIES 
SET FORTH ABOVE, THE SYSTEM IS LICENSED “AS IS,” AN D J.E.I. DISCLAIMS ANY AND ALL 
OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WI THOUT LIMITATION, ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 
TITLE AND NONINFRINGEMENT IN ALL JURISDICTIONS WHER E THESE WARRANTIES MAY 
BE DISCLAIMED IN THE LICENSING OF INTELLECTUAL PROP ERTY. 
 
No Consequential Damages. IN NO EVENT SHALL J.E.I. OR ITS LICENSORS BE LIABLE TO 
LICENSEE FOR ANY SPECIAL, INDIRECT, INCIDENTAL OR C ONSEQUENTIAL DAMAGES, 
INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUES AND  LOSS OF PROFITS, EVEN IF 
J.E.I. OR ITS LICENSORS HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
 
TERM AND TERMINATION 
J.E.I. reserves the right to terminate this License if you have exceeded or attempted to exceed the licensed 
uses in any way. Termination will be effected by written notice to you. UPON TERMINATION OF THIS 
LICENSE, YOU AGREE TO RETURN ALL COPIES OF THE DVR DIGITAL VOICE RECORDER 
(DVRS) SOFTWARE, THE CD-ROM DISCS AND ALL RELATED MATERIA LS AND 
DOCUMENTATION, OR DESTROY THE SAME AND CERTIFY TO J .E.I. IN WRITING THAT YOU 
HAVE DONE SO. 
 
This License constitutes the entire agreement between the parties with respect to the use of the System and 
supersedes all prior or contemporaneous understandings or agreements, written or oral, regarding such 
subject matter. No amendment to, or modification of, this License will be binding unless documented in 
writing and signed by a duly authorized representative of J.E.I. 
 
US GOVERNMENT RIGHTS IN COMMERCIAL SOFTWARE 
Use, duplication or disclosure by the Government is subject to restrictions set forth in the commercial 
computer software license agreement under which the software is delivered by J.E.I. and as provided in 
DFARS 227.7202-1 and 227.7202-3, as applicable, or FAR 12.212(a), FAR 52.227-14 or FAR 52.227-19, as 
applicable.   
DISTRIBUTION GRANT 
This distribution grant is limited to original equi pment manufacturers, assemblers, re-assemblers and/or 
software pre-installers of computer hardware (each a "System Builder" or "SB").  J.E.I. grants the SB a 
non-exclusive right to distribute and sublicense to an unrelated end user J.E.I.’s DVR Digital Voice 
Recorder (DVRS) system as part of the SB’s computer hardware package. The SB may not advertise nor 
price the DVR Digital Voice Recorder (DVRS) system separately from the computer hardware. The SB may 
not modify, repackage or reassemble DVR Digital Voice Recorder (DVRS).  The SB may distribute the DVR 
Digital Voice Recorder (DVRS) system with computer hardware to a SB purchaser only if the SB purchaser 
agrees to all the terms of this Agreement. 
 
 
Copyright © 2002 J.E.I.  All rights reserved. 
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SECTION 1 – INTRODUCTION 
 
Congratulations on the purchase of your new JEI Model DVR version FS Digital Voice Recording 
System.  You have purchased a recording system that incorporates the latest in computer technology 
and JEI’s greater than 35 years of recorder research and development experience.  Your recorder will 
provide the peace of mind that comes from knowing your critical communications are digitally 
captured and archived for as long as is required.   Your DVR recorder requires very little maintenance 
to provide years of trouble free service.   

 
Once connected to an analog audio signal source, the DVR automatically records your communication 
using a voltage drop sensor or Voice Activation circuitry (VOX).  Recorded signals from each channel 
are recorded on an internal hard drive for instant retrieval of your most recent conversations (Instant 
Recall).  At the top of the hour all the new recordings are copied to the archive drive.  You will have an 
automatic backup of all of the recordings. 
 
When the main hard drive fills-up with recordings, the oldest material is deleted from the hard drive first 
to provide sufficient space for new conversations (FIFO - First In First Out). The archive drive can be set 
to do a few different things when it gets close to being full.  The most popular is to let the users know that 
it should be replaced with a fresh blank archive.  Is easy just pull out the full drive and pop in a blank 
one.  The recorder will take care of all the details. 

 
The DVR can simultaneously record and playback so you will not miss recording a new conversation 
while you are listening to an old conversation.  The system allows the conversations in process on any 
channel to be monitored as well.   
 
Your system ships to you configured for recording and ready to go.  One need only connect the cable set, 
power up the recorder, and apply audio signals to start recording.  
 
Provisions for the re-installation of software are provided to allow users to recover from system failures 
or when directed by the manufacturer.   

 
 
IF YOU NEED ASSISTANCE 
 
It is highly recommended that the user review this manual to become familiar with the capabilities of 
the system.  If you feel you need additional assistance, please call (888) 677-2844. 
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SECTION 2 – INSTALLATION 
 
This section covers the proper mounting of your DVR and the steps required to connect your DVR to a 
recording source. 
 
1. MOUNTING 
  
• Mount in a clean, dry and air-conditioned environment.  Excessive heat or cold will negatively affect 

operation. Condensing humidity will likely cause system failure.   

• Excessive dust or sand will interfere with efficient operation of the Archive drive.   

• Mount at eye level, if possible, for easy viewing.   

• Ensure obstructions do not restrict airflow through the side panel and out the rear chassis door.  

• JEI strongly recommends purchasing an Uninterruptible Power Supply (UPS) to allow a smooth 
shutdown of the DVR in the event of a power outage and to provide power surge protection for your 
investment.  

• It is important for trouble free Removable Archive Disk drive operation to mount the system on a 
level surface.  

• For rack mounting, remove the rubber feet and secure the rear of the DVR at the mounting lug.  

• Do not mount near strong RF fields, electric motors, large TV monitors, powered speakers or any 
other strong magnetic field source.   

 

2. POWER 
 
A standard JEI recorder unit is connected to standard 110 VAC or 220 VAC using a power 
cable.  It is highly recommended that a power conditioning circuit be used to supply power to 
the recorder.  On some DVR versions the voltage level should be set via a small red switch 
near the power plug.  DVR units with “Full Range” marking or lacking a red switch will auto 
adjust to the voltage level. 
 
DVR units that are configured for 24 volt power, have an exposed terminal bus for power.  
Connect your 24 volt supply to the outermost terminals using an appropriate gauge wire.  The 
24 volt power system used on the DVR is capable of drawing 700 watts. 
 
DVR units that are configured for 12 volt power, have an exposed terminal bus for power.  
Connect your 12 volt supply to the outermost terminals using an appropriate gauge wire.  The 
12 volt power system used on the DVR is capable of drawing 500 watts. 
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3. AUDIO INPUT CONNECTIONS  
 

 
 
DVR-FS with the High Fidelity Option 
 

JEI Communication Recorders easily connect to a telephone or radio communication source in a 
number of ways.  However, most connections require JEI interface cables or JEI Coupler Devices to 
bring the audio form the source device.  DVR rear panel input connectors are defined at the point of 
sale. 
The DVR-D and DVR-FS models are equipped with either DIN-5 (Standard) or BNC ports. 
 
The DVR-E and DVR-FT models have RJ12 ports. 
 
The DVR-FS models with the High Fidelity option have ports for Mini-XL female plugs  
 
The ideal audio input level is in the -25 to + 4 dBm range.  The input impedance is 10K, unbalanced.  
Any input level between –20dBm (47mv P-P) and +4dBm (3.55v P-P) is acceptable.  Input levels above 
the desired range will be compressed, which reduces the sound quality. 
 
Care should be taken to establish connections with no audible noise on the line.  Any audible noise may 
have sufficient level to trigger the VOX circuit and cause "dead-air" recordings.  This situation is 
especially noticeable in remote radio setups.  Be aware of public address systems integrated with radio 
operations, as these setups can be very noisy.   

 
   

4. DIRECT AUDIO CONNECTION 
 
For Connecting to a DIN-5 Port use the following pin assignments. 

Use a DIN-5 plug.  Connect Pin 3 to positive audio.  Connect Pin 5 to negative audio.  
Coupler voltage is carried on Pin 6 (12 VDC.)  Pin 5 also provides ground. 

 
For Connecting to a RJ12 Port use the following pin assignments. 

Use a RJ12 plug.  Connect Pin 3 to positive audio.  Connect Pin 4 to positive audio.  
Coupler voltage is carried on Pin 6 (12 VDC.)  Pin 1 is ground. 

 
For Connecting to a Mini-XL Port use the following pin assignments. 

Use a Mini-XL female plug (Part number 1003-1163-ND, from Digi-Key Corporation) 
The audio is carried on pins 2 and 3.  Connect Pin 1 to the shielded ground.  Connect Pin 
2 to the negative audio.  Connect Pin 3 to the positive audio. 
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5. TELEPHONE CONNECTION INSTRUCTIONS 
 
The user decides whether they want to record all conversations on a particular phone line or a 
particular phone extension.  For example, if a company has 25 phone lines and 8 extensions, it might 
be more efficient to connect to phone sets or workstations rather than incoming phone lines.  The 
phone set connection is accomplished by the use of a multi-line phone coupler.  By connecting to 
phone workstations, all calls to that workstation are captured no matter how many phone lines are in 
the hunt group.  When connecting to the workstation, it is a simple matter to identify a user with a 
phone and particular conversation with that workstation.  This connection method makes searching 
for audio files much simpler. 
 
Couplers provide the "beep" tone during recording, a legal notification requirement in most states.   
 
Recorders can also be connected via couplers directly to incoming phone lines at the punch down 
block.  This connection method is necessary for certain operations. Microphones can be connected 
either through a coupling device or directly with the proper wiring setup.  Contact JEI for wiring 
assistance. 
 
 
Couplers for direct telephones include the following…  
RTC-100T Single Line Coupler for single line desk phones. 
D-TC-2CA Multi-Line Coupler for multi-line desk phones. 
TC-3 Multi-line Coupler for multi-line desk phones 
 
The specific coupler required considers your phone system and your recording needs.  Contact JEI for 
assistance in matching a coupler to your phones. 
 
 
5.1  TO RECORD ALL CALLS ON A PARTICULAR PHONE LINE   
 
 Part Number RTC-100T Single Line Telephone Coupler  

(Requires 5 Pin DIN or RJ12 jack on rear panel.) 
 
Connect before the Switch (PBX) using a JEI part number RTC-100T (Figure 1) coupler.  A 
telephone technician must install a phone outlet (USOC #RJ-11C jack) from the particular incoming 
analog telephone company (telco) line to the DVR recorder.  This coupler allows for automatic 
recording of all conversations to/from any phone in the facility that uses that one phone line.  The 
coupler triggers recording when it senses a drop in line voltage.  One advantage the coupler has over 
others is it will begin recording from the first telephone ring.  This information can be used to assess 
operator response time.   
 
Notify the Phone Company that you are connecting this coupler to the telephone system.  They will 
want to know the following: 

 
- FCC Registration #HGV-270-17663-RC-N 
- Ringer Equivalence 0.7 

 
Plug the RTC-100T coupler into the incoming telco jack using a standard RJ11 cable, or JEI P/N 020-
10016-001. We suggest that you connect the coupler to the phone before connecting to the DVR.  
Also, we suggest you mount the coupler to the wall to prevent damage to the coupler.  Connect Cable 
Assembly P/N 020-10020-001 from the “To Recorder” jack of the RTC-100T into an open channel 
on the back of the DVR.  You are ready to record. 
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Note:  The recorder will run continuously if the coupler is plugged into the recorder but not connected 
to the phone line.  For this reason, we recommend that the coupler not be plugged into the recorder 
until properly connected to the telephone system.   

 
5.2 TO RECORD ALL CALLS ON A PHONE EXTENSION 
 
METHOD 1  

Part Number TC-3 Multi-Line Telephone Coupler  
(Requires 5 Pin DIN or RJ12 jack on rear panel.) 

 
Connect after the Switch (PBX) to a single-line extension using JEI part number TC-3. A telephone 
technician installs a phone outlet (USOC #RJ-11C jack) that taps into the extension block of a 
particular analog handset1.  This method is used infrequently because of the requirements of digital 
PBX and digital handsets.  

 
METHOD 2  

Part Number D-TC2CA Multi-Line Telephone Coupler  
 (Requires 5 Pin DIN or RJ12 jack on rear panel.) 

 
Connect at the Handset/Headset using a modular 4x4 cable, supplied with the D-TC2CA or TC-3.  
The user can make this connection without the assistance of a telephone technician.  This coupler is 
specifically designed for multi-line phone sets.    

 
Disconnect the handset cord from the telephone base and plug the cord into the 4X4 
receptacle on the JEI coupler.  Plug the short cord on the coupler into the RJ14 receptacle on 
the telephone base (the connector slot used for the handset cord).  Plug the long cord from the 
coupler into any open port on the back of the DVR with the RJ12 connector.  The cord from 
the coupler to the DVR can be extended hundreds of feet to accommodate long distances 
between the DVR recorder and the phone workstation.  Contact JEI for wiring instructions.  
Peel off the adhesive backing on the coupler to attach the coupler to the side or underneath of 
the telephone or desktop. The coupler can be hidden from view. 
 
Note:  Be advised that the wiring sets provided with the DVR couplers are not to be tampered 
with or extended without JEI wiring assistance.  Two of the wires in the cables to the 
couplers provide power to the coupler and are not to be connected to the recorder or phone 
system in error.  It is very important that any extensions of wiring take into account the 
unique pin-outs for each wire and its purpose.  When installing wiring extensions, care must 
be taken to maintain wire color codes from junction to junction.  Do not cross any wires in 
the set from end to end.   
 
On some modern digital phones, the handset stays “live” even when placed in the cradle.  If 
this condition exists, room noises will be picked up and recorded by the DVR.  The condition 
can be stopped or prevented by installing a proximity switch.  The optical proximity switch, 
provided with the TC-3, will tell the recorder when the handset is in or out of the cradle.   
 
                                                 
1 Some phone systems transmit a digital signal from the switch (PBX) to the handset.  These systems 
require a Digital-to-Analog Converter (DAC).  Call JEI with the PBX manufacturer name and model 
number to check DAC availability.    
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6. TWO-WAY RADIO CONNECTION INSTRUCTIONS 
 
To connect the DVR to a two-way radio system requires one of two couplers.  The specific coupler 
required considers your radio system and your recording needs. Connection methods vary depending 
on the make and model of the base station or remote station in use.   

 
 
6.1 TO RECORD AT THE REMOTE STATION: 
 
Part Number D-RC-1  
(Requires 5 Pin DIN or RJ12 jack on rear panel.) 
 
This part is used to connect the DVR to a remote station.  You have a remote station if your radio 
transmitter is NOT near the station.   
 
Suggested methods of connection to the remote station: 
• Remote (RTO) Line Connection – Both transmit and receive sides should be available.  
• Unswitched Audio Outlet (Audio A Connection) – Many remote control stations are equipped 

with an outlet for connecting an amplifier or remote speaker for monitoring both transmit and 
receive audio.  If available, this outlet provides an excellent point for connecting to the DVR.   

• V.U. Meter Connection – If a V.U. meter is in use for monitoring both transmit and receive audio, 
connection can often be made at this point.  One side must be chassis ground or isolation is 
required. 

• Monitor Receive Connection – If it is not possible to make a satisfactory connection to the base 
station, it may be necessary to use an independent monitoring receiver.  Connection can be made 
directly across the speaker terminals.   

 
Note:  The volume control of the receiver should be secured so that it cannot be moved after the 
proper level has been set. 
 
Plug the RJ-type connector of the output cable on the coupler into the desired available channel on the 
back of the recorder.  You are ready to record. 

 
 
6.2 TO RECORD AT THE BASE STATION 
 
Part Number RTC-100R 
(Requires 5 Pin DIN or RJ12 jack on rear panel.) 
 
This part is used to connect the DVR to a base station.  You have a base station if the radio 
transmitter is near the recorder.   
 
The RTC-100R mixes the base radio microphone and speaker audio to record both parts of radio 
conversations.  
Connect an RJ11 gray satin cable, contacts 3 and 4 (the middle 2 of the 4 contacts of an RJ11) to the 
base radio speaker circuit. (JEI P/N 020-10017-001)  This is an isolated input so polarity is un-
important. The RJ11 plugs into the “Rx” port of the RTC-100R. 
 
Another RJ11 cable (JEI P/N 020-10017-001) attaches to the microphone circuit of the base radio.  
Attach the RJ11 contact 3 to "Mic Hi" and contact 4 to the shield ("Mic Lo").  The microphone circuit 
must be arranged so that the microphone is alive only when the PTT circuit is activated. The RJ11 
plugs into the “Tx” port of the RTC-100R. 
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Use the 020-10020-001 cable assembly to connect the “To Recorder” output of the RTC-100R to the 
desired available channel on the back of the DVR-FS. NOTE: This cable utilizes two of its 6 
conductors to power the RTC-100R. DO NOT CONNECT THE RADIO DIRECTLY TO THE DVR-
FS.  
 
 
7. EXTERNAL RECORDING CONTROL 
 
Some models of recorder units offer external control of the recording process.  Units equipped with 
this feature will have DB-9 connectors on the rear panel.  If a cable is plugged into this port, the cable 
will control if audio is passed along to the recorder for the associated channel ports. 
 
Each pair of channels will have a DB-9 female connector located between the channel ports.  This 
connector will provide a control point for the two channel ports on the same row.  An 8 channel 
record will have 4 DB-9 control points. 
 
Each control port is a normally open circuit.  When the circuit is open, no recording will happen on 
the controlled channel.  If the circuit is closed, audio will be passed along to the recording processor. 
 
For example, if you have a foot switch and the end of the control cable, stepping on the footswitch 
will allow recording.  You could also use a toggle switch or a Push-To-Talk style button.  (In this case 
it would be a Push-to-Record button.)  An 8 channel recorder will have 4 control cables and 8 switch 
devices. 
 
7.1 CONSTRUCTING A CONTROL CABLE 
 
To use the recording control, you will need a custom cable that attaches to your control devices or 
switches.  The following diagram shows how the cable needs to be constructed. 
 

 
Start with a DB-9 male connector.  To control the right channel port, connect pins 1 and 2 to 
one side of a switch device.  Connect pin 6 to the other side of the switch device. 
To control the left channel port, connect pins 4 and 5 to one side of a switch.  Connect pin 9 
to the other side of the switch. 
 
The circuit provides 12 VDC so you can wire in an indicator LED if you would like. Pins 6, 
7, 8, and 9 are all ground pins. 12 ma flows when the circuit is closed. 
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8. KEYPAD CONVENTIONS  
 
The 3U DVR units have built-in Keys on in the front panel for performing all user commands.   User 
preference may dictate the addition of an external USB keyboard and mouse. 
 

 
Figure 2.3 Keyboard Layout 
KEY  Used for 

 

ESC Go Back to Previous Menu/selection buttons 
TAB Move to the next field or button 
BSPACE Erase characters one at a time from the editable fields. 
ALT tab navigation (i.e. ALT+1) 
ENT Enter Key 
P Scroll a screen full at a time in lists 
P Scroll a screen full at a time in lists 
Arrow Keys  list navigation (one recording at a time) 

*  Wild Card to be used in Check boxes/Search/Reports (i.e. 001*) 

- Range selection to be used in Search/Reports (i.e. 1 – 5) 

, Multiple selections to be used in Search/Reports (i.e. 2, 1, 5-6) 
Numbers Data entry and channel selection 
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9. ACTIVITY INDICATOR LIGHTS 
 
(Optional feature) 
 
Some Models of JEI Recorders have indicator lights on the front panel.  On a DVR-FS model the lights 
are paired with a sensitivity knob below the lights.  Turn the knobs to set the VOX sensitivity.  The lights 
indicate that VOX has been detected.   DVR-E models have lights that show the sound activity.  They 
will flicker as the sound levels change. 
 
Recorders with the High-Fidelity options do not have functional front panel indicators.  However, the 
LEDs may still be installed in the unit.  In this case the LEDs will always be dark. 
 
10. REAR OUTPUTS 
 
(Optional feature) 
 
Recorders with the High-Fidelity option include rear panel output BNC connectors.  The Left connector 
is for the playback of recorded audio.  The Right connector is for the monitor function.   
 
Sound will be produced from the front speaker.  The speaker can be set for either playback or monitor 
depending on the position of the channel selector switch.   The volume of the speaker can be controlled 
using the volume knobs just below the speaker. 
 
The rear outputs always use the maximum available volume.  The rear panel playback and monitor ports 
can output audio at the same time. 
 
11. TURNING ON THE SYSTEM FOR THE FIRST TIME  
 

1. Locate the system carefully.   Route the audio feeds to the recorder unit carefully.  Be mindful of 
nearby devices producing strong magnetic fields. Do not place the recorder in direct sunlight.  
Sun glare my make the monitor impossible to see. 

 
2. Plug the power cord into a surge protector and/or Un-interruptible power supply.  The DVR 

power supply can be set for 120 or 220 VAC service.  Make sure the switch in back is set to the 
proper value for your local electric service. 

 
3. The DVR-FS system comes with a SATA hard drive installed in the carrier, ready to archive at 

the top of each hour (default setting). DO NOT attempt to remove the drive until familiar with all 
instructions pertaining to use of the removable SATA system.  
 
Contact J.E.I. for important information regarding SATA replacement hard drives. 

 
4. Attach an external keyboard, mouse or full size monitor prior to applying power to the system.   
 
5. Press the power button to start the machine. 
 
6. Type 09876 in the LOGIN field to access the system. 
 
7. Double click on the Channel 1 icon or type the number "1".  The View tab will be a activated 

and display a list of recordings.  Press the "enter key" once.  The highlighted file will be 
opened in the player and begin playback.  If audio is present your system arrived in good 
health and is ready for recordings. 
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8. The DVR-FS utilizes the latest Serial ATA (SATA) hard disk drives to archive 

critical recordings.  With some care and general maintenance, the DVR’s Removable 
SATA Disk drive will provide years of trouble free service. The Removable SATA 
Disk stores information just like the system’s main internal hard drive.  Your DVR-FS system 
has been shipped with the SATA Archival disk installed. See Section 4 for instructions on 
how to mount subsequent replacement drives. 

 
The DVR system utilizes a highly customized Windows 7 Professional operating system.  Do 
not attempt to adjust any settings on the Operating System. Any attempt to change the 
parameters of Windows 7 Pro, other than items that JEI makes available to users will result 
in voiding of the warranty.   JEI may authorize users to make changes to the system.   

 
Be advised a full size color monitor, full size keyboard and mouse can be added to the 
system in the event space is not an issue.  This manual addresses both stand-alone 
operations as well as expanded operations with extended equipment lists.   

The integrated 5” monitor screen is monochrome.  

A VGA Monitor may be connected to the rear VGA port to utilize a color screen.  

Depending on the model, some JEI units have DVI video only.  For these units, a DVI to 
VGA converter will allow a VGA monitor to be connected to the DVI port. 

Some Advanced Recorders may be equipped with only HDMI video output.  HDMI to VGA 
converters are available for using a VGA monitor. 
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SECTION 3 – BASIC OPERATION 
 
 

1. GETTING STARTED 
 

a) Verify that ALL CONNECTIONS and all system checks described in Section 2 have 
been preformed. 

b) Start the system by pressing the POWER switch.   

 

 

 

 

  
 
 
 
Figure 3.1.1 DVR-E 
 
 

c) Once the operating system as started, the JEI 
splash screen will appear (Pictured Right.) 
The Splash screen contains JEI’s address, 
phone number and website if you need to 
contact JEI.  The splash screen will be 
displayed for a few seconds, to avoid 
waiting, press the Enter key. 
 

d) A progress bar will be shown while basic 
checks and diagnostics are processed.  The 
recorder is capturing audio during this 
process.  Please do not interrupt the recorder 
while this progress bar is displayed.  We 
have attempted to make the verification 
process as efficient as possible so it really should not take long. 

Mono / Stereo Switch  

Archive Storage   

Keypad 

Volume  
Controls 

Power Switch 

5" CRT 
Screen 

Headphone 
Jacks - 2ea 

Channel Selector   
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c) Once the startup processing is complete, 

you should see the Status tab.  The Status 
tab displays the information about the 
condition of each channel available on 
your recorder.  There are also some basic 
controls available from this screen.  
(Many of which are optional and your 
recorder might not show them.)  More 
information about the Status tab is 
contained in section 3.   You will notice 
that most of the items on the screen are 
inactive – that is because you need to 
logon to the system before you can access 
any of the features or recordings.  
 
This screen is the starting point for most activity on the recorder.  If at any time you 
have trouble using a feature and need to start over – just keep pressing the escape key 
until you get back to the Status tab.   
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2. USER ACCESS 
 
LOG ON 

 
a) In order to gain access to the recordings on the 

recorder, you must logon first. Type the user login in 
the login field at the bottom of the screen. If it seems 
that you cannot type anything press the escape key 
until a cursor appears in the field.  Once you have 
filled out the field, click the OK button or press the 
Enter key. 
 
THE FACTORY INSTALLED 
ADMINISTRATIVE LOGIN IS 09876 . 
 
Use this Login to enter the system for the first time.   
Make sure to change the assigned logins for the administrator and create new users 
immediately.   

 
b) When a valid login is entered, all of the feature and tabs will be enabled and the color of 

the elements will change depending on the users access level additional tabs may be 
shown.  If a tab you were expecting to see is absent, an administrator might have changed 
your access level or you have accidentally used the wrong account.  Logout and try again. 

 
c) If an incorrect Login is entered, the system prevents access to recorder and displays the 

“ Invalid Login” message in the lower left hand corner of the screen.  Other messages 
may appear here as well.  

 
The JEI DVR has three levels of access to recording reports and system features.  These 
levels of access correspond to the individual’s job duties.  The number of accessible tabs and 
other features are controlled by the access level. The three access levels are: Operator, 
Supervisor, and Administrator.   
 

• The Operator has access to the Status, View, View All, and Search tabs to enable 
them to search and playback the recordings.  Access can be established for all or 
selected channels.  

 
• The Supervisor has access to the Status, View, View All, Search and Archive to 

enable them to search and playback the recordings.  The Archive tab gives the 
Supervisor access to the historical recording and allows him to safely remove and 
replace existing archive drives.  Various export features allow supervisors to send 
recordings to CDs or memory sticks. Access can be established for all or selected 
channels. 

 
• The Administrator has all the access of the Supervisor plus access to the Admin 

Settings tab.  Admin Settings is the tab for setting all the global recording settings, 
turning on/off features, and establishing user access.   Administrators are also the 
only users that can safely shutdown the recorder. 

 
For information on establishing logins and access levels, refer to Section 5, System 
Administration Settings. 
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LOG OFF 

 
If the current user is inactive for an extended period, the DVR will automatically log out the 
user.  The automatic logoff interval can be set by the administrator using the Settings tab. 
 
The automatic log off feature prevents unauthorized access to recording by individuals 
without logins.   
 
The administrator can disable the automatic logoff feature by setting the logout period 
to zero.  In that case the system will not force any user to logoff. 
 
The current user can end the session immediately by clicking the logout button on the 
Status tab (which should be done every time the user expects to leave the room.)  
 

3. RECORDER STATUS 
 

a) The Status tab consolidates information on recorder activity.  The user can monitor the all 
recording channels and the removable SATA archive cartridge info. 

  
Figure 3.3.1 – Status Features 

 

b) The system Date and time is displayed in the top left corner. 

c) Archive status is in the upper right hand corner of the screen 

d) The center of the screen provides a graphical display of the various recording channels.  
Using color and icons, the user can quickly see the recording status of each channel.    The 
colors of the Channel Buttons indicate:   

• Blue = Recording in Progress 
• Green = Ready to Record 
• Fault = Recording Disabled because of Problem 

System date/time 

Recording in 
Progress 

Channel Off 
(optional) 

Channel Ready 
to Record 

Monitor this 
channel (optional) 
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• Idle = Recording Disabled by System Administrator 
 

e) The channel buttons also provide quick access to the list of recordings on a particular 
channel.  There are three ways to jump from the Status tab to the view tab: 

• Use the Mouse to left click on the channel button; 

• Use the Tab or Cursor keys to highlight the channel of interest and hit the Enter key;  

• Use the number keys to type the channel number. If your recorder has more than 9 
channels, you will have to use 2 numbers to identify the channel – so channel 5 will 
be accessed by using the "0" key followed by the "5" key. 

Of course, your user must have access rights to the channel before you can see the recordings. If 
you cannot get to a particular channel, check with the administrator to see if the channel has been 
assigned to you. 

 

f) The small speaker icons below each channel button control the monitor circuit.  Click on the 
speaker icon to engage the monitor for that channel.    You will also need to verify that the front 
panel channel selector is set on position 1 so that the audio will be routed to the speaker.  
Monitor can only observe one channel at a time.  You will have to click it off before selecting 
another channel to monitor.  This feature is optional and not available on all recorders. 

NOTE: The front panel selector will have to be switch back to the playback setting so that you 
will be able to hear the audio.  If you launch the player but dot hear anything – check the channel 
selector switch. 

 

g)  The on/off button below the channel icon can enable or disable recording on the 
corresponding channel.  This is most useful for conference room recording solution where 
individual microphone must be turned off in certain situations. This feature is optional and not 
available on all recorders. 

 
4. VIEW Tab 
 

a) The View Screen displays all the 
recordings for the selected channel. In 
the example (Shown Right), the 
recordings on Channel 1 are 
displayed.   

 
b) The View tab displays the event 

number, Date, Time, Duration, and 
other information for each recording.  
The blue highlight bar indicates the 
selected recording.  A use can select a 
recording using a variety of methods  

 
o Use the Mouse to click on a row 

to select it 
o Use the Up and down arrow keys  
o Use the Page up and page down keys 
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c) The system assigns a unique Event # for your convenience.  It would be a good practice 
to write down important event numbers on reports during an incident so that the audio 
can be retrieved quickly. 

 
d) The date, time, and duration show the recorder time when the recording began.  Once 

recorded this time cannot be changed.  The Duration is filled with question marks 
(??:??:??) to indicate that a recording is currently under way.  The Duration shows hash 
marks or pound signs (##:##:##) to indicate that the recording was interrupted.  This is 
typically due to the recorder unit being restarted or a loss of power. 
 
If the system time is changed, backwards or forwards the new time will be used only 
when a new recording begins.  This can lead to some “time gaps” appearing in the list of 
recordings – no recordings were actually missed it just looks strange in the list.  It is 
important that the recorder time clock is set accurately coordinated with the other time 
systems in your organization. 

  
e) The “Cc” column indicates that this is a continued call.  If the letter “C” appears in the 

“Cc” column, the captured audio is longer than 1 hour in duration.  The recording and the 
following recording should be considered as a single event.  No audio data is lost – is has 
simply been split into more than one part.  The maximum recording size of one hour was 
selected to limit the file sizes to manageable chucks that other software (like CD writers) 
can handle.  This is a safety feature to prevent run away recordings that could waste hard 
drive capacity.  If the channel is full of continued calls, you should adjust the recording 
sensitivity for the affected channel. 

 
f) To play the selected recording, simply press the Enter key or double click the left mouse 

button.  Verify that the channel selector switch on the front panel is set on the Playback 
setting to route the audio to the speaker.  The JEI Player (See the next section) appears 
and starts playing the corresponding audio.  Once you are finished listening to the audio 
press Escape to exit the player. 

 
g) You can play back a recording that is currently recording, simply by selecting it in the list 

and playing it like any other recording.  A few of the player features will be disabled.  
This capability is known as Instant Recall. 
 

h) The Mark  button places a marker on the selected recording; an “M” indicator will be 
added to the record.  This indicator can be used to flag particular records as being 
important. 

 
i) The Note Button allows you to enter important information about the call.  The text 

entered in the Note Editor is saved when the editor is closed.  The note editor can be 
closed by clicking on the X in the top-right corner or by using the ALT key to access the 
File menu.  The File menu has both a Save and an Exit option.  The Exit option both 
saves the text and exits the editor.  The search features of the recorder will allow you to 
find recordings based on the contents of the notes.  The first 20 characters of a note 
appear on the view tab. 
 

j) To exit the View tab and return to the Status Screen, hit the Escape key until you return 
to the Status tab or click on the Status tab with the mouse. 
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Caution: Some DVR recording systems are capable of high fidelity recordings using 48 kHz 
sample rates.  Older sound cards may only operate up to 44.1 kHz sample rates or lower and 
thus playback will be inoperable.  If you must playback using a lower fidelity sound card then 
you must adjust the recorder to record at no more than the maximum available sample rate of 
that sound card. 
 

5. PLAYBACK CONTROLS 
 

a) Once the JEI Player (shown below) opens it will begin the playback immediately.  

b) The playback clock, located in the upper left hand corner of the screen, shows the actual 
time of the recording and track the current play position as the audio proceeds.   

 

 

 
 

 

 

c) At any time during playback, a portion of the original audio file can be selected as a segment 
for repeated playback – called a Subset.  

i. Click the mouse or press 1 on the subset control when the playback reaches the 
starting point of the playback portion you wish to separate.  The number “2” will 
appear on the circular digital display.   

ii. Click the mouse or press 2 on the subset control again when the playback reaches the 
end point of the playback portion you’ve separated.  The number “3” will appear. 

iii.  You have now marked a specific portion of the audio recording for repeated play/study. 

iv. If you click on the subset control again or hit the 3 keys, you will reset the subset 
shown on the time progress bar.   

v. You can select the loop control to playback any portion of a recording over and over 
by click on the loop control or press 5.   

vi. The subset time interval clock shows the start and stop time of the subset selected.  

Playback 
Time 
Clock 

Time Progress Bar Playback Subset 

Subset 
Time 
Interval 

Volume Control 
 (Up/down Arrow Keys) 

Mute 
Control 

Subset 
Control 
(button) 

Full Rewind 
Rewind 
Forward 
Full Forward 
 

Jump to next 
Recording 

Play 
Pause 
Loop 
Stop 

Speed Control (Keys 9 & 8) 
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d) The player can be closed, at any time by, pressing the Escape key or clicking on the exit 
button at the top right corner.  

e) The Speed control (keys 9 & 8) change the playback speed of the audio.  Increase the speed 
by moving the marker up or tap the 9 key.  Decrease the speed by moving the marker down 
or using the 8 key. 

f) All functions can be accessed without a mouse via the keyboard by the items listed below 
each control. 

ENTER Play  7 Jump to End 

ESC Close the player  4 Mute 

, (comma) Pause  ▲ Increase Volume 

5 Loop  ▼ Decrease Volume 

* Stop  9 Increase Speed 

HOME Jump to beginning  8 Decrease Speed 

6 Jump to beginning  0 Jump to next recording 

◄ Fast Rewind  1 Start a Subset 

► Fast Forward  2 End a Subset 

END Jump to End  3 Clear the Subset 

 

6. VIEW ALL 
 

• Displays a more recent list of all 
channels in chronological order.2  The 
View All tab (Figure 3.12) is useful 
when you are not sure of the specific 
channel that contains the recording of 
interest.  View All helps if an incident 
involved recordings that were 
captured on many channels. 
 

• If you are currently on the View tab, 
press Escape once and use the right 
arrow to activate the View All tab or 
use the mouse to activate the tab. 
 

• An asterisk (*) in the “Arc” column 
indicates that the recording have been copied to the archive device.  This allows you to track 
the progress of the archive. 
 

• The Refresh button will update the list with the latest recordings. 
 

• In most other ways the View All tab works the same way as the View tab (including selecting 
and playing back recordings). 

                                                 
2 Only most recent recordings are displayed. More recordings may be found by using the search features. 
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7. SEARCHING 
 
The search tab allows the user to search for 
recordings by any combination of channel, 
date, time, or audio source.  Searches can be 
refined to include or exclude radio, 
microphone or telephone channels. There are 
four modes of searching, use the "MODE" 
button to switch to the next mode. The general 
search locates recordings that started between 
two specified date/times.  The Spanning 
search locates recordings that started before 
and end after a specified time.  The event 
numbers locates specific event numbers.  The 
text search will locate recordings base on the 
attached notations. 
 
The Buttons 
 
All of the search modes us a common set of buttons along the right edge of the Search tab.  
As you use the Mode button to change from one search mode to the next, these buttons will 
remain on the screen. 
 
The Search button initiates the search process.  Each time the search is engaged the results list will be 
cleared and repopulated with recordings that match the search criteria.    If no recordings match your 
search criteria, which could happen if your date range is too far in the past, a message will let you 
know the no records were found. 
 
The Clear All button erases the search results list, empties (or resets) all the search criteria fields and 
resets the checkboxes to the default state.  Think of it as the OOPS button. 
 
The Clear Row Button removes the selected row from the search results list; this can be used to fine-
tune the list before printing a report or making a playback collection for external recording. 
 
The Mode Button switches to the next search mode.  The modes are General, Spanning, Event, and 
Text.  Specifics of each mode will be covered in the next section. 
  
The Print button prints a report of the entire search results list.  A printer must be attached to the 
printer port on the back of the Recorder for this feature to function.  Printing is restricted to 
Supervisor level access.  If your access level is not high enough, the print button will never become 
enabled. 
 
The Export button will allow Supervisors 
and Administrators to make copies of the 
specified recording to some other media 
(either a Flash Drive, a folder on the archive 
drive, or a custom location.) 
The user may export the Highlighted 
recording in the search results or the user 
may export the entire contents of the list. 
 
The user enters the search criteria into the white field boxes.  Once you have filled-in the field press 
the tab key to move to the next field. 
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The General Search 
 
The channel field will specifies a particular channel (1) or a list of channel numbers (1,3,5) or a range 
of channels (2-6).  The search will be confined to the channels listed in the field. 
 
The “Marked” search options allow a user to search based on the Marker flag on the View tab.  The 
user can narrow a search to include just the recordings that are marked, the recordings that are not 
marked, or choose the ALL option to ignore the marker status of recordings 
 
The Date and Time fields allow users to specify a starting date and time and an ending date and time.  
The recordings listed will only be the records that are between the two date/times.  The user can skip 
entering the starting date/time to get the recordings that occurred before the end date/time.  The user 
can skip entering the ending date/time to get the recording that occurred after the starting time.  The 
time fields are optional and do not have to be entered in which case the date/time will not be a factor 
in the search process. 
 
The Inputs selectors allow a user to search for records that come from a particular type of input 
source.  The default input is “All” which really tells the search not to worry about the input source.  
Any combination of Radio, Mic, and Phone may be selected.  The search results will be filtered to 
include only records that match one of the checked inputs. 
 
The Spanning Search 
 
The Spanning search is really more intuitive; it works much more like a brain works.  Specify a date 
and time of interest and time period.  The search results will bring back the recordings that were 
actually recording at the specified time.   
 
The channel field will specifies a particular channel (1) or a list of channel numbers (1,3,5) or a range 
of channels (2-6).  The search will be confined to the channels listed in the field.  If you leave the 
channel field blank all channels will be included in the search. 
 
The Date and Time fields allow users to specify a date and time of interest. Since the Spanning 
Search is a precision search, all of the date/time fields must be entered.  
 
The time span selectors allow you to set the tolerance of the search.  If you select the 10-minute 
option, the search will find recordings that start or end within 10 minutes of the specified time. 
 
The input selectors (Radio, Mic, and Phone) allow a user to restrict the search results to recordings 
that come from the specified input sources.   
 
The Marked checkbox is a special case, if it contains a check mark, the search will find ONLY the 
recordings that have been marked.  The unmarked recordings will not appear in the search results. 
 
The Event Search 
 
Once the Event search is displayed the event number field will automatically be active and ready to 
accept your search criteria.  You can enter either entire event numbers or partial event numbers.  
When entering partial event numbers the asterisk (*) can be used to denote a partial search.  The use 
of the asterisk is optional.  This is a precision search, it is easy to make a typo in the event number 
field. Don’t get discouraged – check your event number and just try the search again. 
 
The Text Search 
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Once the Event search is displayed the event number field will automatically be active and ready to 
accept your search criteria.  You can enter the text you need to find.  The notes for all recordings will 
be examined and if your search text appears in the note the recording will be added to the search 
results.  The text search looks for the exact phrase that you enter in the field. For example, if you have 
the following information on the recorder: 
 

Recordings 
Event # Note:  
00105242006163243 123 West-Any St 
00105242006164437 321 West Any St 
00105242006172266 123 East Any St 

 
Search criteria of "Any St" would return all three of these recordings.  A search of "123" would find 
the first and third recordings.  A search of "West Any" would only find the second recording.  The 
first record is not found because the hyphen in the first note does not match the search criteria. It is a 
good idea to keep the search phrase as short as possible to generate the most matches.  However, 
searching for common words is not really a good idea either.  A search for "the" is likely to bring 
back more recordings that necessary.  It may take a couple of attempts to get a handle on good search 
phrases for your organization. 
 
The Results 
 
Once you have entered the search criteria and started the search, the system will create a list of 
matching recording.  This might take several minutes if the recorder has been running for a long time 
and has stored a lot of recordings.  
 
The Clear Row, Note and Print buttons will become enabled once the results grid fills with 
recordings. 
 
The search results list operates just like the View tab in regards to navigation, selection and playback.  
Simply highlight a recording and press Enter to open the JEI player. 
 
As an optional feature, some recorder models include the export button.  If this button is available, it 
enables the user to copy all the recordings in the search results to a specific folder. 
 
Some recorders, depending on model, offer an 
additional feature on the Search tab.  The Matrix 
Player feature allows a user to select multiple 
recordings for playback at the same time.  If you 
select only one recording your will get the traditional 
single recording player. Select several recordings 
from the search results list using a click and drag 
operation via the mouse.  When multiple recordings 
are selected the enter key will start the Matrix Player. 
The matrix playback interface is pictured to the right.   
 
Most of the features in the JEI Player have been 
replicated in the Matrix Player.  All of the key controls are the same. The subset controls are the 
same. The volume and speed controls are the same.  One of the new features is the ability to mute and 
unmute a channel while it is playing.  Click the channel number of the channel you wish to mute and 
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it will be silenced.  Repeat the process to bring it back.   Muted channels will have a red strikethrough 
drawn on them as well as a mute marker placed next to the channel number. 
 

 
8. CD Burning 
 
(Optional feature) 
 
The CD tab is available only to supervisors and administrators.  The tab allows the operator to select a 
series of recordings using searches and burn them to a CD-R disk.  The CD Tab works much the same 
way as the Search tab.   The CD tab search results include a checkbox for each row of the results.  A 
checkmark in the checkbox indicates that you want that recording burned to the CD.  You can toggle 
the checkmark on and off by clicking on it.  You can also toggle the checkmark by highlighting one 
or more rows and pressing the spacebar. 
 
Once you have selected all the recordings you want, place a blank CD-R* in the CD drive and click 
on the Burn CD button.  A progress bar will be displayed while the recordings are copied to the buffer 
folder.  Once the CD contents are prepared the CD Burning software will be engaged automatically.   
When the process is complete, the CD will be ejected.  You just need to wait for the drive to open. 
 
* The CD burning process requires a blank unformatted CD-R (CD dash R) disk.  You cannot add 
files to an existing CD-R. 
 
9. SHUTDOWN PROCEDURE 
 
Following the proper shutdown procedure prevents hardware damage and/or data corruption.   
 

� Login as Client Administrator 
� Stop the signals prior to shutdown (recommended) 
� Go to the Settings tab 
� Click Shutdown 

 
The recorder should power down.  If a Windows message appears stating that it is safe to 
shutdown the system, press the Power Button down and hold it until the system stops.  
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SECTION 4 –SATA ARCHIVE SYSTEM 
  

The DVR-FS utilizes the latest Serial ATA (SATA) drives to archive critical recordings.  
With some care and general maintenance, the DVR’s removable SATA disk drive will 
provide years of trouble free service. Every hour on the hour the DVR-FS Recorder will 
automatically Archive the last conversations recorded during the previous hour.  The SATA 
drive will continue to archive hourly until such time that it fills.  The recorder will notify the 
user that the drive is NEAR FULL or FULL. 
  
IMPORTANT NOTES:   

• SATA archive hard drives are supplied for use in the DVR-FS / DVR-ES series systems only. 
Storage of any files other than those made in a DVR system using the J.E.I application may 
disrupt recorder operation and, under certain circumstances, may invalidate the warranty.  

• To maintain the continuity and sequential order of the call records, use each SATA archive 
disk to its full capacity before replacing. 

• When it is time to replace the archive drive, it is safe to have it removed from the system for 
up to 24 hours. The main system drive will continue to store all calls and will perform the 
archiving operation once the new drive is installed. 

• The system administrator needs to determine the archive retention periods required for the 
facility. Records older than the required age can be erased during a reformat operation 

 
J.E.I. Part Numbers and Recommended SATA replacement drives: 
        015-10018-001 SATA drive carrier (hard mounted in DVR chassis) 
        015-10019-001 SATA drive tray, removable 
        042-10011-001 SATA Hard Drive, replacement (J.E.I. part no.) 
 

      Recommended replacement SATA drives: 
              ST3500641AS SATA drive, 500 GB, Seagate part no. 
              SSDSC2CW120A310 SATA drive, 120 GB SSHD, Seagate part no. 
              ST310005N1A1AS-RK SATA drive, 1 TB, Seagate part no. 
 
1. ARCHIVE TAB 
 
The Archive Screen is give users acess to a number of 
functions that deal with the archive disk.  The archive 
tab shows some basic disk usage information at the 
bottom of the screen.  When the available portion is less 
than 10% you should prepare another archive disk. 
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The View Button 
 
The View Button will call up a list of the recordings on 
the Archive Disk.  This list allow you to play back the 
recordings by selecting a recording and pressing the 
enter key.  You can also double click on the recording to 
play it.  It is likely that there are many thousands of 
recordings on the archive drive so this list could be very 
large.  You can press the Escape key to return to the 
archive menu. 
 
 
The Search Button 
 
The user can perform two types of searches: General and Event.  The General search feature allows 
recordings to be located by any combination of channel, date or time.  Searches can be refined to 
include or exclude radio, microphone or telephone dedicated channels. The Event search feature 
allows the user to directly specify which recordings to locate. 
  
General Search 
 
The Archive General search operates in a similar manor 
to the Search tab.  Enter the search criteria in the text 
boxes and click the appropriate check boxes and click 
the Search button.  The display will list all the available 
recordings that matching the criteria. 

 
To play a highlighted recording, hit the Enter key.  You 
can also double click using the left mouse button on the 
recording of interest.  The JEI Player appears and starts 
playing the corresponding audio file. 

 
Press the Escape key to close the playback and return to the Search.  

The Clear All button will erase the search results and set all the search criteria to default values. 

The clear row button allows you to remove recordings from the list to fine tune your search results. 

The Mode button will switch to the event mode search. 

The Print  button allows you to print a report to a printer attached to the recorder.  All of the 
recordings in the list will appear in the report. 

The Export button allows Supervisor and Administrators to copy recordings to external media. 

You can use the Escape key to return to the Archive Menu. 
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Event Search  
 
The Event Search is useful when the user knows the 
specific event or events.  It is also useful in situations 
involving multiple events for the user to recreate an 
incident.  The event search has only one field for the 
event number - simply enter an event number or the 
first part of an event number and press the enter key or 
click the search button.  The results are accumulated so 
you can repeat the process to build up a list of events. 
    
In all other respects the event search is identical to the 
general search.  
 
Use the Escape key to return to the Archive Menu. 
 
The Mount/Unmount button 
 
The mounting control button changes state depending on presents of an Archive Disk.  This button 
allows you to safely add or remove an Archive Disk.  Instructions on using this button appear in the 
next section. 
 
The Manual Backup button 
 
The recorder automatically copies all new recordings on the hard drive to the Removable SATA 
Archive Disk drive at the top of the hour.  The system hard drive provides instant access to the most 
recent recordings while the Removable Archive Disk is the archival medium for long-term storage. 
 
The manual backup button forces the archive operation to happen on demand.  Once the operator 
triggers the manual backup, the files that have not already been archived will be copied to the archive 
disk. 
 
The Advance Backup button 
 
The advance backup button will copy all the recordings from the internal storage location to the 
archive drive.  The advance backup should only be used on relatively fresh (new or reformatted) 
drives.  This feature might be useful if you have just changed archive drives and wish to have some 
amount of redundancy.  It might also be useful if someone wants an “extra” copy of the recorders 
contents. The advance backup will not change the status of the recordings in the View All tab. 
 
Archive History Button 
 
The user can request a summary report of all SATA Archive Disks created on the DVR-FS by 
selecting the Archive History button.  The report provides the following information, the archive 
identifier, the machine number, the date of the earliest recording on the archive, the date of the latest 
recording on the archive, the identifier of the old archive identifier if this driver has been recycled, 
and the status of the drive.   
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2. REMOVING AN ARCHIVE DRIVE 
 

There is no need to turn off the power to the DVR-FS while removing or 
installing an Archival Disk.  A supervisor can remove the drive while the 
power is running. This feature is called “hot swap”.   

 
The following procedure will take you through all the steps to safely remove the archive. 
 

• Logon as an administrator or supervisor. 
• Go to the Archive Tab.  
• Click on Unmount Button.  
• DVR will pop up a warning message. Read 

and follow the instructions. 
• Push the button at the top of the drive carrier. 

The lever handle will pop out. 
• Swing the handle fully downward (near 

perpendicular to face of unit). This will 
disengage the drive tray from the carrier. 

 

 
 

• Pull the drive out gently 
• Windows may display a warning screen or a small popup at the 

bottom of the screen about removing the drive.  The screen will 
appear as picture to the right:  

 
• Click the OK button to dismiss the warning.  The recording data 

on the drive is safe - the DVR system has already finished 
writing all the files.   

 
• Click OK if Window Delayed Write failed screen 

appears.   
 
 
• Click OK on the JEI warning message 
• Button Unmount will change into Mount and “ARCHIVE READY” message will be 

replaced with “ARCHIVE NEEDED”. 
 

• Do not leave Archive Disk drives sitting unprotected on a desk or near any field inducing or 
magnetic equipment.  Store them carefully away between uses. 
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Note:  It is not necessary for a Removable Archival Disk to be present for the DVR to record to its 
main drive.  The SATA drive may be absent for at least 24 hours without any chance of data loss. 
 

 
3. REPLACEMENT OF A REMOVABLE SATA ARCHIVE DISK 

 
Caution must be taken to mount and insert the Serial ATA Hard Drive in its tray properly to prevent 
damage to connectors on the drive or the carrier mechanism.  To ensure the SATA Drive is inserted 
properly, follow these steps.  
 
a. If your tray has a shell, you will need to remove it before installing a drive.  The shell is just clipped 

in place but it may be very tight and you may need to use a screw-driver to remove it. 
 
b. Position the tray on a flat level surface with the open side up. Lay the bare SATA drive, label side 

up, flat inside the tray with the drive connector toward the open end of the tray. Ensure the threaded 
mounting holes on the sides of the drive line up with the through holes on the tray. 
(JEI provides the first drive already mounted.)  

 
c. Install four (4) 6-32 x 3/8 binder head screws (included with tray).  2 per side, to attach the drive to 

the tray.   
 
d. Orient the SATA drive with arrow up and handle down. 

 
e. Slide the Removable Archive Disk tray into the drive bay carefully until the drive comes to a stop  

 
f. Use the key to lock the drive in place, the lock also engages the power to the drive and the green 

light should become illuminated. 
 

Due to the volume of data that can be stored on a Removable Archive Disk, it can take up to 2 minutes to 
access the stored files. Allow the Archive Disk drive to position the disk before performing another 
archival operation.  The Archival Disk indicates that it is ready by displaying “Archive Ready” at the top 
of the screen. 
 
4. FORMAT THE SATA ARCHIVE DISK: 
 

Disk you must have a correctly formatted SATA Disk with space available to perform normal 
archive operations.  You have the option of using a brand new drive or reformatting one of your 
old ones.   Any formatting operation will erase any data from SATA Archive Disk. 
 
Follow these steps to Format a New SATA Archive Disk or reformat an Existing SATA Archive 
1. Go to the Admin Settings.  
2. Click on System Configuration.  
3. Click on the Format Removable Drive  
4. Click Yes on the warning screen 
5. A popup progress bar shows that the format is working. The top right corner shows the 

percentage of the format of the SATA Archive Disk.  
6. User may not use the system until the format is complete. 
7. Recording of any incoming audio is not interrupted by this operation. 
8. User can use the Network client to access the audio files. Or FTP the audio file from the recorder 

while the recorder is in format mode.  
9. User interface will display the new ARC  # on the top left corner and ARCHIVE READY on the 

top right corner.  
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10. The recorder returns to the normal mode operation.  A backup will occur at the top of the next 
hour. 

 
5. ARCHIVE STORAGE AND HANDLING 
 
Do not leave Archive Disks on top of the recorder, near power radio microphones, under stapled or 
paper clipped documents, near magnetic fields, motors, fans, TV's or any other mechanical devices. 
 

• Use a clean, dry, low-moisture container in an air-conditioned environment.  Do not 
store in temperatures outside of 65 to 85 degrees F range.   

 
• JEI suggests placing the Archive drives in a corrugated cardboard box, or original 

packaging, inside a locked file cabinet or storage locker. 
 

6. MOUNTING AN ARCHIVE DISK 
 
To Mount Removable SATA Archive Disk to the DVR unit, follow these steps: 
   

• Follow instructions in Section 4.3 for physically installing a SATA drive in the 
removable tray and inserting it in the carrier. 

• Orient the SATA drive with arrow up and handle down 
• Slide the SATA Drive into the bay carefully until the Drive comes to a stop. 

(Note the drive is ½ inch short of being completely pushed into the drive bay.) 
• Lift the handle up and lock it by lightly pressing inward. (In this process the drive 

is completely engaged and flush with the recorder.) 
 

 
 
 

• Wait for few seconds. 
• Tab to the Archive menu and Click the Mount button.   
• Click OK on the warning message 
• “Mount” button will change into “Unmount” and “ARCHIVE NEEDED” 

message will be replaced with “ARCHIVE READY”. 
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SECTION 5 - SYSTEM ADMINISTRATION SETTINGS 
 
The Settings tab contains buttons to configure all the 
features of the recorder. The administrator can adjust 
the configuration to the needs of the organization.  Each 
of the Settings Buttons will call up the settings covering 
a particular aspect of recorder operations. 
 
There are many settings that can be customized or 
adjusted to get the maximum benefits from the recorder.   
 
Each button will be detailed in the remainder of this 
section. 
 

 
1. CHANNEL CONFIG 

 
The Channel config button will 
display the settings for one 
channel at a time.   
  

 
Channel Drop-down Selector:  
This control allows the Admin to 
select which channel is displayed 
on the rest of this tab.  Click the 
down arrow and select a channel - 
the other values on the form will 
change to reflect the setting for 
that channel. 
 
Type: The type selector allows the 
Admin to set the display Icon for 
the current channel.  The choices 
are Phone, Radio, and 
Microphone. 
 
Display:  The display selector allows the Admin to switch from an icon representation to a text label. 
 
Description:  The description appears on the Status tab and other places.  The description can 
represent anything that is useful for your organization.  Typical examples are phone numbers, radio 
identifiers, or functional names. 
 
Record:  Individual channels can be disabled or enabled.  If the Record button reads YES, the channel 
will record normally.  The record button is duplicated on the Status tab on some models of recorders. 
 
VOX: The VOX button controls weather or not the recorder is voice activated or not.  If this button 
reads YES, the voice activation circuit is engaged.  If this button reads NO, the channel will record 
continuously while the Record button has a value of YES.  There are few reasons to ever have this 
value set to NO. 
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AGC Level:  The Automatic Gain Control (AGC) circuit inside the recorder offers three levels of 
operations.  The highest level (2) is very aggressive at capturing voice – JEI recommends this level in 
most cases.  The middle setting (1) uses an algorithm which is more suited for non-voice sounds.  The 
final level (0) turns the AGC circuit off.  The AGC level can be set on a per channel basis. 
 
Hold Time:  The hold time slider sets the amount of silence it takes to end a call.  While a call in 
being recorded the system tracks the volume of the call, when no one has spoken for the specified 
hold time the recording is ended.  If the caller starts talking again, a new recording will be started.  
You may want to increase the hold time if you subjects talk with longer gaps in their conversations.  
This might be the case with communication systems like ship-to-short calls where there is a 
discernable gap between speakers. 
 
Hold time will NOT address pings and pops in your audio.   Such line noises are better address by 
adjusting the source equipment. 
 
Start Threshold:  The VOX circuit that determines when to record uses the Start Threshold to decide 
when to begin a recording.  This value is rated in decibels.  A value of 0 dB represents a very loud 
sound.  A value of -40 dB represents a very quiet sound.  The slider sets the triggering point for the 
VOX circuit. 
 
Stop Threshold:  The stop threshold slider set the value the VOX circuit uses to decide if a recording 
should end.  This value is rated in decibels.  If the incoming audio is below the stop threshold for 
longer than the Hold Time the recording is stopped.  
 
Gain: The Gain slider is used to modify the strength of the incoming signal.  This is not exactly the 
same as a volume control.  When adjusting the Gain it is highly recommended that Gain settings be 
changed by small amounts at a time.  If the gain is set too high, distortion will result and the audio 
will sound bad.  The gain setting addresses audio quality not volume.  If you want the playback to be 
very loud, use amplified speakers to the listen to the recordings.  Changes in Gain may require a 
system restart before they affect the recorded audio. 
 
Save:  The Save button will commit the settings displayed on the page to the current channel.  The 
save button ONLY affects the channel specified in the Channel Selector dropdown.  Each channel's 
settings must be saved separately. Remember to save your settings before you select a different 
channel. 
 
Defaults: The Defaults button changes the Hold Time, Thresholds, and Gain back to the factory 
defaults. 
 
Setup Menu: This button returns to the previous Settings Menu. 
 
NOTE: Any adjustments to the Threshold or Gain values could result in either distorted recordings or 
loss of audio.  Make any adjustment is the smallest possible increments.  Run the recorder for several 
minutes and collect a number of recordings to see if the change has given you the desired results. 
 
NOTE: If the recorder is recording when you make changes to the settings, the recording may be 
stopped and restarted. 
 
NOTE: It is strongly recommended that you restart the recorder after you have made adjustments to 
all the channel settings.  On some recorder models the settings will not take effect until after a restart. 
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2. USERS 
 
The JEI DVR has three levels of access to recordings, reports and system features.  These levels of 
access correspond to the individual’s job duties.  The three access levels are: Operator, Supervisor, 
and Administrator.  The greater the level of access given to an individual, the greater number of 
screens and tabs the person will have access to. 
 

Operator 
Operator has the lowest level of access rights. 
They have access to the Status, View, View All, and Search tabs to enable them to search 
and playback the recordings.   Access can be established for all or selected channels.  

 
Supervisor 

Supervisor is the next higher level of access.  A supervisor has all the access of an Operator 
plus access to the Reports and CD tabs.  These permit the generation of reports, search/play 
of CDs. 

 
Administrators 

The Administrator has the highest level of access to the DVR.  The Administrator has all 
the access of the Supervisor plus access to the Admin Settings tab.  Admin Settings is the 
tab for setting all the global recording settings, turning on/off features, and establishing user 
access.  

An administrator can click on the Users button in the settings to manage the recorder users.     
 

 
 

Figure 5.2 – Passwords Configuration 
 
The password configuration display includes the Username, login, access level and a series of 
checkboxes that define which DVR resources that the user is allowed to use.  Now the details… 
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Username: The username allows the administrator to assign a name to the user.  This is strictly for the 
administrators benefit.  The name may represent a class of user, their roll, their position, their actual 
name, or any other value that the local administrator deems useful.  Just click on the field to change 
the text. 
 
Login:  The login is the value (or pin number) that the user will enter to access the system.  The 
default user configuration includes 2 administrators, one supervisor, and one user.   As shown in 
figure 5.2 you can add other users to the system.  You can also change the login by clicking on the 
login field that you want to change. The minimum login length is 5 characters the maximum length is 
10 characters.  You must use the enter key on the keyboard or keypad to finish editing a login value.  
If you just click out of the field your changes will not be saved.  The system will validate that the new 
login entered is valid and unique.  The login value will revert to the original if it is rejected. 
 

We strongly suggest that logins be confined to numeric characters 
since they are available from the built-in DVR keypad.   

 
Access: The user access level sets the amount of resources and information that a user is allowed to 
access.  User levels were detailed in subsection 3 above.  If you click on the access level a dropdown 
list of available access levels will appear and allow you to select a new access level for the user.  The 
system will verify that you have at least two users with the ADMIN access level.  If you need to 
demote an ADMIN user, you must first promote another user first.  In other words, you must set up a 
third ADMIN before demoting one of the existing admin users. 
 
Remote:  The remote checkbox indicates weather or not the user is allowed to access the recorder 
remotely.  This setting will be used in a future version of the JNCS software.  The JNCS client 
software will examine this setting and only give access to user that have this field checked.  If the 
user does not have remote permission the JNCS software will reject the login. 
  
Numbers:  The remaining columns represent the channels. The user will only be able to access 
recording on channels that have checkmarks.  This will allow the administrator to restrict access to 
sensitive channels to selected individuals.  You will notice that there may be more channels listed 
here than are available on your recorder – this was done to support any future upgrade path for your 
recorder.  (We can transfer configuration information such as your user list to a higher channel count 
recorder at the factory.) 
 
The Save Button will commit the changes you have made to the user settings.  You must click the 
save button in order to retain the settings – if you leave the users screen without saving – your 
changes will be lost. 
 
The New button will add a new user to the list.  The user will be assigned default values and be 
assigned a unique password.  You can change the information before you press the save button. 
 
The Client Setup Menu button will return you to the previous menu.  If you press this button before 
you save your changes – the changes will be lost.  
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3. SYSTEM SETTINGS 
 

Machine Name:  The machine name 
identifies the recorder.  This is useful if you 
have multiple recorders.  The machine name 
also appears on printed reports and is used 
by the archive system.  Do not change the 
machine name. 
 
System Date/Time: The Sys Clock button 
will bring up a dialog for changing the 
system date and time. The IRIG button will 
open the IRIG settings panel for recorder 
unit equipped the IRIG cards.  Change the 
Time/Data will require that the system 
perform a reboot. 
 
Inactivity Logoff:  As a security feature, user inactivity (not moving the mouse or touching keys) will 
cause the system to automatically logoff.  The inactivity period can be specified in the Setting | 
System Config page.   If this value is set to zero (0) the automatic logoff is disabled.  (However, the 
screen will still shut off after 20 minutes of inactivity.) 
 
Frequency Band (optional, HF models only):  High Fidelity recorder units have two selectable audio 
frequency settings.  They may operate in a low band setting of 300-10kHz or a high band setting of 
20-20kHz.  When the Frequency Band setting is changed, the sample rate and bit rate settings will be 
automatically set for appropriate values.  Low band bitrates are 8, 16, and 32.  High band bitrates are 
64, 128, and 256.  If the Bit Rate setting is changed, the Frequency Band setting will also change to 
reflect the new bit rate value. 
 
Sample Rate (optional):  The sample rate dropdown selector allows the admin to set the recording 
frequency.  Higher frequencies result in better quality audio.  High Sample Rate audio recordings 
consume disk space at a much higher rate.  Recording capacity will be greatly reduced as sample 
rate increases.  Some recorders have fixed sample rate hardware and ignore this setting. 
High Fidelity recorders show a minimum sample rate for the given Bit Rate.  On these recorders this 
setting may not be changed by the user and is shown for informational purposes only. 
 
Bit Rate (optional):  The Bit Rate dropdown selector allows the admin to set the Bit Rate for 
recording. Higher Bit Rates result in better quality audio.  Recording capacity will be greatly 
reduced as Bit Rate is increased.  For very low bit rate settings, the full audio frequency will be 
sacrificed.  If recordings sound “tinny” or “hollow” increase the bit rate. 
 
Archive Interval:  The interval dropdown selector allows the admin to set the period between 
backups.  The minimum backup period is 1 hour. 
 
Serial Number:  This field specifies the internal hardware serial number for the recorder unit.  Do not 
change this value unless asked to do so by a JEI technician. 
 
Enable Mouse: Some models of JEI recorder are configured as rack-mount units that do not have 
space for a mouse device.  This button lets the recorder know that this is the case. 
 
Logoff Stops Monitor:  If the monitor circuit is set to listen to a live channel, the monitor will be 
silenced when the user logs off.  If this button is set to NO the monitor will stay on, even after the 
user logs off. 
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Logon Stops Monitor:  If this button reads YES, the monitor will be turned off when a new user logs 
onto the recorder. 
 
Restamp Removable Drive:  This button will replace the identity information on a removable SATA 
Archive Disk.  No recording on the archive drive will be affected.  This button allows a user to move 
an archive drive from one recorder (such as a primary unit) to a second recorder (such as a backup 
unit) without loosing any information.  The process will make a new entry in the Archive History. 
 
Format Removable Drive:  This button will format a removable SATA Archive Disk.  If there is 
information contained on the disk it will be erased.  This process will need to be performed when a 
new archive disk is added to the recorder. The process will make a new entry in the Archive History. 
 
Save:  The Save button will commit the settings displayed on the page to the system. 
  
Setup Menu: This button returns to the previous Settings Menu. 
 
4. REPORTS (ADMINISTRATIVE) 
 
The JEI Recorder provides some basic administrator 
reports. All the reports are printable in any printer attached 
to the recorder. 
 
Using the report is simple: Select one of the reports and 
click the print button.  This will bring up a print preview 
window. If you actually need to print the report click the 
print button on the preview panel. 
 
 
 
 
5. NETWORK CONFIGURATION 

 
The JEI Recorder is pre-configured with Basic Network 
settings.  Click the Network Control Panel button to access 
the settings. 
 
The JEI Recorder is configured as a FTP server for wide-
area access to the recorded audio. All the settings are pre-
set by JEI technicians and should never need to be 
changed.  The FTP provides read-only access to the recent 
audio. Click the FTP Server Setup button to access the 
settings. 
 
The JEI Recorder is set to use just one Windows User.  If you need to change that user's login, click 
the User Manager Button. 
 
The Upgrade button allows the admin to upgrade the recorder software.  This should only be used on 
the advice of JEI personnel. 
 
The Network Copy button will bring up the settings for the Network Duplication features.  This 
feature will make duplicates of the recordings on another computer. The target system can be another 
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computer on the network or a FTP server.  There are some special considerations that must be made 
on the target computer.  Please contact JEI for more information on this feature. 
 
6. DELETION 
 
Choosing the Delete button from Client Setup 
menu allows the administrator to delete selected 
channels of audio.  The delete system removes 
entire channels of audio not individual recordings.  
The DVR operates this way to protect the chain of 
evidence and allow the recorder to server as an 
indicator that a call did NOT occur.  Deleting a 
whole channel meets most security concerns and is 
obvious and deliberate.  
 
Delete affects only the main drive.  Archive disks 
are unaffected. 
 
Warning: Any delete activity is permanent.  
There is no method available that will recover the thousands of recordings and the associated data.  
JEI recommends performing a manual Backup before using this option.   
 
Once the delete screen appears, select the channels you wish to delete by putting checkmarks in the 
boxes next to the items.  You can put the checkmarks using the mouse or by using tab to move to the 
checkbox and then pressing the asterisk (*) key. 
 
The numbers shown in the center of the screen represent the channels. 
 
The Archive History checkbox represents the historical list of the archive disks.  If you delete this 
history the next disk will be formatted as REG-1. 
 
Once you have selected the item you want to erase.  Click the Delete button.  A confirmation message 
will appear showing the items you selected. Click the OK button to proceed or the Cancel button to 
abort the deletion operation.  If you choose to proceed, we are going to give you another chance to 
cancel.  If you still choose to proceed, the recorder will delete your selected items and then 
automatically reboot. 
 
If you really want to delete everything on the recorder, the Delete All button will do the job.  We use 
the Delete All button just before we ship the recorders from the factory to clear out any test data 
generated during the quality assurance phase of production.  The Delete All button resets the recorder 
to a factory fresh condition. 
 
Note: After deleting one of the channels, you may notice that the View All list still contains files – 
this is intentional.  The View All list is essentially a view into the archiving and data recovery 
mechanism of the recorder.  Performing channel based delete operations would induce too much 
processing and the recorder would take longer to recover.  Since our goal is to bring the recorder back 
online as quickly as possible, the View All list is exempt from deletion on a channel by channel basis.  
If you really need to delete the View All list your only option is to use the Delete All button. 
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7. COMPANY INFO. 
 
The Company Info button will bring up a form that the 
admin can use to identify the company that owns the 
recorder.  This information will appear on some of the 
reports generated by the system.  
 
Just fill out the form and click the Save button. 
 
 
8. ABOUT US 
 
The About Us button will show you a little bit about JEI 

 
9. RESTART 

 
The restart button will save all recording information and safely reboot the recorder.  This may be 
necessary when changing settings.  A restart may also be necessary if the network (usually network 
servers) have had a major change or reconfiguration.  
 
10. SHUTDOWN 
 
The shutdown button will save all the recording information and safely power down the recorder.  If 
the operating system puts up a "ready to shutdown" message, just hold the power button down until 
the recorder shuts off. 
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SECTION 6   Technical Specification - FS SERIES  
 Narrow Band High Fidelity 

RECORDING CHANNELS 2, 4, 6, 8, 10, 12, 14, 16 2, 4, 6, 8  

RECORDING MEDIA 
Internal (System) 

 

500 GB SATA, standard 500 GB SATA, standard  
120 GB SATA, SSHD Opt * 

RECORDING MEDIA 
Archival  

500 GB SATA, standard 500 GB SATA, standard  
120 GB SATA, SSHD Opt * 

APPROXIMATE RECORDING 

TIME3 
SYSTEM HARD DRIVE 

@Bit Rate 

107,600 hours @ 8 kbps  

58,400 hours @ 16 kbps 
30,000 hours @ 32 kbps 

107,600 hours @ 8 kbps on 500GB 

58,400 hours @ 16 kbps on 500GB 
30,000 hours @ 32 kbps on 500GB 

3,800 hours @ 256 kbps on 500GB 

23,000 hours @ 8 kbps on 120GB 

8,000 hours @ 16 kbps on 120GB 

6,700 hours @ 32 kbps on 120GB 

900 hours @ 256 kbps on 120GB 

 

APPROXIMATE RECORDING 
TIME 

REMOVABLE ARCHIVE 
DISK 

@Bit Rate 

110,000 hours @ 8 kbps 
59,700 hours @ 16 kbps 

31,000 hours @ 32 kbps 

110,000 hours @ 8 kbps on 500GB 
59,700 hours @ 16 kbps on 500GB 

31,000 hours @ 32 kbps on 500GB 
3,650 hours @ 256 kbps on 500GB 

26,000 hours @ 8kbps on 120GB 

14,300 hours @ 16kbs on 120GB 

7,400 hours @ 32 kbps on 120GB 

840 hours @ 256 kbps on 120GB 

 

DIGITALIZATION 

METHOD: 

MP3 MP3 

SIMULTANEOUS RECORD 

AND PLAYBACK 

YES YES 

Record Control (VOX) Standard Standard 

Record Control 

 (Contact Closure) 

Available Option Available Option 

Input Level Maximum +16 dBu />10K Ω +24 dBu />10K Ω 

Input Impedance 10 K Ω 10 K Ω 

Operational Input Level -25 to +4 dBm -25 to +6 dBm 

VOX SENSITIVITY 

CONTROL 

Per Channel Per Channel 

INPUT CONNECTORS Din-5 w/Coupler 

RJ-11, Direct 

Mini-XL, Direct only 

 

Record Level Automatic  

(AGC with Limiter) 

Selectable: 

None, Standard, Aggressive 

BIT RATE, supported 

(kBps) 

8, 16, 32 8, 16, 32, 64, 128, 265 

FREQUENCY RESPONSE 300 HZ TO 10KHZ 300 HZ TO 10KHZ  

20 HZ TO 20KHZ @ 256 BPS 

HARMONIC DISTORTION ≤ 3% @ 300-3400 Hz ≤ 1% @ 20-20kHz 

DYNAMIC RANGE > 50 dB > 70 dB 

SIGNAL TO NOISE RATIO >38 dB > 55 dB 

OUTPUT:  FRONT PANEL 

SPEAKER 

YES YES 

                                                 
3 Channel hours are approximations.  Actual depends on traffic intensity and channel settings. 
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OUTPUT: 2 FRONT 

HEADPHONE JACKS 
 

YES YES 

OUTPUT:  REAR PANEL 

BNC 
 

Optional 

 

Optional 

 

TIME/DATE FORMAT4 24 HR. MIL. Format 24 HR. MIL. Format 

Size 19.0” WIDE Per EIA 
Standard 

5.25" HIGH  

16.0” DEEP 

19.0” WIDE Per EIA Standard 
5.25" HIGH 

16.0” DEEP 

Weight 20 Lbs 31 Lbs 

Form Factor Rack Mount Rack Mount 

Colors Black Black 

Power Requirements 115/230 V AC 50-60 HZ 

DC Output 550 Watts 

115/230 V AC 50-60 HZ 

DC Output 550 Watts 

Optional 12 Volt DC 500 Watt 500 Watt 

Optional 24 Volt DC 700 Watt 700 Watt 

External Monitor Port Available Standard 

Time Synchronization NTP 

IRIG (optional) 

NTP 

IRIG (optional) 

Network Interface Standard Standard 

 

Environmental Specifications:  
OPERATING 
TEMPERATURE 

5°C to 40°C 0°C to 40°C 

STORAGE TEMPERATURE -20°C to 65°C -5°C to 70°C 

HUMIDITY 20 - 80% RH Non-

Condensing. 
 

20 - 80% RH Non-Condensing. 

 

OPERTING ALTITUDE 0 – 7,000 Ft. Max 0 – 7,000 Ft. Max 

VIBRATION OPERATING  Swept Sine 5 to 500 HZ 

@.25 \g peak 1 octave/min 

3 axis,  

3 Directions 

 

Swept Sine 5 to 500 HZ @.25 \g peak 1 

octave/min 3 axis,  

3 Directions 

SHOCK OPERATING No Data Loss,  Halt Sine, 

Performance,  5 G peak 3 
MS, 

 3 Axis, 3 Directions,  
 Internal 10 seconds. 

 

No Data Loss,  Halt Sine, Performance,  5 

G peak 3 MS, 
 3 Axis, 3 Directions,  

 Internal 10 seconds. 
 

 
                                                 
4 Date and Duration of each Conversation are provided 
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SECTION 7 - GENERAL MAINTENANCE 
 
The DVR-FS is a high-tech instrument incorporating precision mechanical assemblies, 
electronic circuitry and custom software.  It is designed to operate continuously and reliably 
for long periods of time.  Preventive maintenance will help ensure your DVR-FS provides 
trouble free operation.  
 
1. CHASSIS 
 

a) Clean the keyboard and front panel components as necessary, with clean water and a 
soft cloth.  Do not use harsh chemicals to clean the external components. 

b) The DVR-FS recorder has a CRT Screen that can only be cleaned with clean water 
and a soft cloth.  Any application of window cleaners or any vigorous scrubbing will 
permanently damage the screen. 

 

2. INTERNAL SYSTEM MAINTENANCE  
 

a) Every 6-9 months, it is advisable that the chassis cover be removed on the DVR-FS to 
accomplish basic component cleaning.    

b) Shutdown the system by double clicking on Shutdown/Restart from Client Setup 
Menu.  

c) Remove either the top cover or the back cover to expose the internal components of 
the system. 

d) Touch an exposed metal part with your hand prior to touching anything else or 
ground yourself with a ground strap to prevent static hits.  

e) Use compressed air to clean all the cooling fans - CPU, chassis and power supply.  
Check that the fan blades move freely after cleaning.   

f) Apply even pressure to the tops of all computer cards to ensure that they are properly 
seated in their card slots.   

g) Check for burn marks or wiring chaffing against fans or metal edges.   

h) Blow the motherboard clean with compressed air. 

i) Turn the chassis upside down to dump any last hidden materials. Press the computer 
cards back down into their slots.   

j) Plug the power supply into a voltage source and start the system with the cover off.   

k) Make sure all the fans are running smoothly. 

l) Go through the shut down procedure and reinstall the cover.   

m) Test the box carefully after cleaning. 
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SECTION 8 –Removable OS/DATA Disk (Optional) 
 
The following option is designed for situation in which the recordings are required to be 
secured when the recorder is taken off-line for an extended period.  The JEI recorder solves 
this problem by placing both the operating system and the data storage on its removable drive 
system.  If the unit needs to be secured, the drive is removed and moved to a secure location 
or locked in a safe.   
 
1. REMOVING THE OS/DATA DRIVE 

 
1. Shutdown the recorder 

1. Logon as an administrator 
2. Select the Settings tab 
3. Select the Shutdown button 
4. Click the Yes button to verify shutdown 
5. Click the Yes button to confirm shutdown. 
6. Wait for the system to shutdown. 

 
2. Remove the drive. 

1. Push the button on the front of the drive tray.  The lever handle will pop out. 
2. Swing the handle fully outward (nearly perpendicular to the face of the unit).  This will 

disengage the drive tray from the drive bay.   The following diagram illustrates.    

 
 

3. Pull the drive out gently, stop half way and take a firm grip on the body of the drive. 
4. Close the handle by pressing it towards the drive until the latch click into place. 
5. Place the drive in an anti-static container.  
6. Store the drive in a secure location. 

 
Note:  The REMOVALBE OS/DATA configuration prevents the recorder from operating while 
the drive is removed. 
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2. MOUNTING THE REMOVABLE OS/DATA DRIVE 
 

Caution must be taken to mount the OS drive tray into the drive bay.  Damage to connectors on the drive 
or the bay mechanism will prevent proper operation of the recorder. To ensure the OS Drive is inserted 
properly, follow these steps.  
 
1. Verify that the recorder unit is powered off 
2. Remove the OS Drive from its anti-static container. 
3. Press the latch button on the front of the tray. 
4. Swing the lever handle out until it is nearly perpendicular to the face of the tray. (Do not force it – the 

plastic arm can break.) 
5. Orient the drive so that the button is at the top and the handle is at the bottom. 
6. Place the back end of the tray into the drive bay.  Line up the groves in the tray with the groves in the 

bay.  The tray will only fit in the bay one way – if it seem stuck or blocked, turn the tray over and try 
again. 

7. Slide the tray forward into the bay until it stops.  It will not be flush with the front of the recorder.  
About ¼ to 1/8th of the drive tray should be exposed. 

8. Swing the lever handle up until it locks into position.  This action should pull the tray all the way into 
the drive bay and lock. 

9. The following diagram illustrates the process… 
 

 
 

10. Once the drive tray is properly inserted into the drive bay, start the recorder unit using the 
power button on the left side of the recorder unit.  The recorder will boot to the OS and 
automatically begin recording. 
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SECTION 9 – DVR-ES/FS PLAYBACK SYSTEM (Optional) 
 

 
1. GETTING STARTED 
 
Double Click on the JEI Playback icon from 
the Desktop or run the software by using the 
Start menu.  The Status tab allows you to 
select the location drive for your archive.  You 
can also mount/unmount an archive disk from 
this screen.  The Export Path indicates where 
recording files will be located when the export 
features are used. Click the Browse button if 
you would like to select an alternative folder. 
 

The SATA Archive Disk should already be 
connected to your PC.  If the archive drive is 
not connected to your PC, connect it before 
using the Mount button in the playback software. 
 
You can add the SATA Archive Drive using an external SATA and power cable.  You may also 
have a removable bay installed in your PC.  Contact JEI on other way to connect the SATA 
Archive to your PC. 
 
Due to the volume of data that can be stored on a Removable Archive Disk, you must wait for the 
Archive Disk drive to settle into an operating state before performing any other Archival drive 
operations.  Once the drive settles, click the mount button to check access.  The Archive Disk drive is 
ready when the status message in the upper right hand corner of the monitor changes from “Archive 
needed” to “Archive Ready”. 
 
The View Screen displays all the recordings from the 
archive.  

The DVR shows the Date, Time and Duration of each 
recording.  The system assigns a unique Event # for your 
convenience.   
 
If the letter “C” appears in the “Cc” column, the recording is 
longer than 1 hour in duration.  For a recording that last 
longer than one hour, the DVR creates an additional time 
stamped audio file for the time beyond 1 hour.  No audio 
data is lost.  This is a safety feature to prevent run away 
recordings that could waste hard drive and tape capacity.   

 
To play a particular recorded file, move the blue highlight bar to the 
recording of interest and hit the Enter key or left click the mouse.  
The JEI Player Screen (shown right) appears and starts playing the 
corresponding audio file.   
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2. ARCHIVE SEARCHES 
 
The user can perform two types of searches: General and Event from the Search & Report tab.  
General searches for recordings can be accomplished by searching Combination of channel, date or 
time.  Searches can be refined to include or exclude radio, microphone or telephone dedicated 
channels. When the user knows the event number(s) of a recording, they can search by these numbers.     
 
The search options have a common set of buttons on the right edge of the screen. 
 
The search button activates the search.  In most cases the Enter key will also activate the search. 
 
The Clear All button clears the recording list and resets the search criteria fields. 

The Clear Row button removes the highlighted rows from the results list. 

The Mode button will change what criteria the search is based upon.   

The Print  button will sent the list on the screen to a local printer. 

The Export  button will give you options to copy the recordings to your local drive. 

The Matrix Play  button will open the selected recordings in the Matrix Player.  This player will play 
the recordings based on their time sequence. 

 
2.1 GENERAL SEARCH  
 
Enter the search criteria and click the Search button.  The 
DVR displays all the available records matching the criteria.   

 
To play a recording, press the Enter key or double click on the 
recording of interest.  The JEI Player Screen appears and starts 
playing the corresponding audio file. 

Press the Escape key to close the player and return to the 
Search tab.  

 
 
2.2 EVENT SEARCH 
 
The Event Search is useful when the user knows the specific 
event or events.  It is also useful in situations involving 
multiple events for the user to recreate an incident.  
    
To search for a specific event, type the event number in the 
Event Number field and click Search button.  
 
You can enter additional event numbers to build up the list. 
 
 
3. FINISH 
 
When you are done examining the SATA Archive drive, simply close the application.  You 
may disconnect the drive and return it to its storage location or put it back in the recorder 
unit. 
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SECTION 10 –NETWORK CLIENT (optional) 
 
INTRODUCTION 
 
Congratulations on the purchase of your new JEI Digital Voice Recording Network Client Software.   
You have purchased a Network Client Software system that incorporates Microsoft’s simple network 
computer technology using TCP/IP. Works on the Local Area Network by connecting the JEI Digital 
Voice Recording system and the client on the (same Domain/workgroup) Ethernet Network...  The 
Client software works under Microsoft Network environment.  
 
 
IF YOU NEED ASSISTANCE 
 
Review this manual to become familiar with the content and material.  If you feel you need additional 
assistance, please call (888) 677-2844. 
 
 
INSTALLATION 
 
This section covers the proper step-by-step installation of your Client Software.  
 
1. SYSTEM REQUIREMENTS: 
 
Hardware: 

 Intel Dual Core or better 
2.0 GB RAM Minimum 
Minimum 4 GB Hard Disk Space 
Network Card 10/100  
Sound Blaster 16 PCI or compatible (48 kHz sample rate or better) 
Speaker (Amplified) 

 
OS: 
  Window XP Professional 
  Windows 7 

 
Software/Drivers (Mandatory) 

 
DirectX 8 or greater (Windows NT) 
NPRunTime (Provided by JEI)  
 
 

2. INSTALLING: 
 
Depending on the model of your recorder, the JNCS system may need to be installed in two 
separate parts.  Some recorders will need a special sound driver (NPRunTime) to help decode 
the audio.  If the JNCS install CD does not include the NPRuntime folder, do not be 
concerned; your recorder does not require the driver, just skip to the JNCS installer section. 
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NPRunTime Installation: for Windows XP 
 

1. After the regular desktop display appears insert JEI CD 
2. Using Windows explorer Go to the CD Drive 
3. Go to NprunTime\2000XP_602e folder 
4. Double Click on Setup 
5. Click the Next Button on the Welcome screen 
6. Click Yes to the License agreement screen 
7.  Click Yes to the Read me first screen 
8. Click Next to the Destination Folder (Default) 
9. Uncheck Drivers for the first group of Boards 
10. Uncheck Drivers for the second group of Boards 
11. Leave Check on Virtual PCX components 
12. Leave Check on Sentinel Driver 
13. Click Next 
14. Click Yes to the License agreement 
15. Click Next 
16. Click Next 
17. Select the “Yes, I want to restart my computer now” option 
18. Click the Finish button, you computer will restart 

 
JEI Digital Recorder Network Client System (JNCS) Installation: 

 
1. Make sure the client PC and JEI DVR-FS Recorder connected to the same Network  

(Workgroup or Domain and VLAN) 
2. After the regular desktop display appears insert JEI CD 
3. Using Windows explorer Go to the CD Drive 
4. Double Click on JNCS_SETUP 
5. Once the Welcome Screen appears, click the Next button 
6. Choose an Installation Type and click the Next button 
7. Choose a Destination Folder (or accept the default) and click the Next button 
8. Choose a Program Folder for the Start menu and click the Next button 
9. Choose if you want a Desktop Icon and click the Next button 
10. Verify your choices and click the Next button 
11. Once the installation is complete, click the Finish button 
12. Restart Your Computer. 
 

 
 

Caution: Some DVR recording systems are capable of high fidelity recordings using 
48 kHz sample rates.  Older sound cards may only operate up to 44.1 kHz sample 
rates or lower and thus playback will be inoperable.  If you must playback using a 
lower fidelity sound card then you must adjust the recorder to record at no more than 
the maximum available sample rate of that sound card. 
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BASIC OPERATION 
 

3. GETTING STARTED  -  
 

a) Use the Start menu to navigate to programs and 
select JEI, then select JNCS or double click on 
the JNCS icon on your desktop. The JNCS 
software displays the Login screen. 

b) DVR Machine Name Drop-Down List shows 
available JEI Digital Recorders attached to your 
Network. 
This will be blank the first time the software is 
started. 
 

c) Click the Network Configuration button to 
locate the Recorders on the network. 
 
A warning screen will let you know that this is a 
process that should only be done by a network 
administrator.  Click the proceed button to get to 
the settings. 
 

d) The Configuration screen is a little daunting but 
it really just has many ways to do the same 
operation.  It builds a list of recorders on your 
network. 
 

e) The first option is to search based on the name 
of the Recorder.  All recorders have a name that 
begin with the letters "DVR", but you will still 
have to know the full name of the recorder.  
Enter the name in the first field and click the 
Add button.  If the name can be located, it will 
be added to the Known Recorders list on the left. 
 

f) If you know the IP Address assigned to the 
recorder, you can use the second field to locate 
the device.  Click the Add button to check the IP 
Address and add the recorder to the list. 
 

g) If you have more than one recorder or cannot remember any of the details, a Search by 
Workgroup may help.  Enter the name of the workgroup assigned to the recorder.  JEI assigns 
the recorders to the workgroup named "WORKGROUP" at the factory.  Enter the workgroup 
name and click the Search\Add button.  All the recorders in the designated workgroup will be 
added to the Known Recorders list. 
 

h) If the recorder has been added as a member of your domain, enter the domain name in the last 
box and click the Search\Add button.  All the recorders in the designated domain will be 
added to the Known Recorders list. 
 

i) Once the Known Recorders List is populated, click the Save button.  You will be returned to 
the Login screen. 
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j) If you need to start over for some reason, click the Clear List button to erase the Know 

Recorders list. 
 

k) If you just want to get out of this screen without making any changes, click the 
Cancel button. This will return you to the Login screen. 

 
NOTE:  If you change the name of any recorder the list will have to be cleared that the 

location process will have to be repeated. 
 
 
4. PASSWORD/LOGON  
 
Once the initial setup is complete, the DVR Machine Name Drop-Down List shows available JEI 
Digital Recorders attached to your Network.  Simply choose the recorder you would to see.  If only 
one recorder is in the list, you do not have to do anything and can jump to the password field. 
 
The software automatically chooses the correct username to access the recorder.  It appears 
on the display only for informational purposes. 
 
The password filed will be pre-loaded with the last password that was used.  If you want 
secure password handling, so that the user must enter the password every time, give JEI a call 
and we will help you configure the software to disable the password memory feature. 
 
If the password field is blank, enter the windows network password for the recorder. 
 
Click the OK button when you are ready to connect.  JNCS will attempt to connect to the 
recorder.  If there are any problems connecting JNCS will display a message at the bottom of 
the screen. 
 

Tip: If JNCS reports the error “NetBT timed out”, make sure that your computer has 
NetBIOS over TCP/IP enabled. 
 
You might also get this error if the name of the recorder has been changed. 

 
Once the recorder verifies your windows password, 
JNCS will establish a persistent connection with 
recorder and the application window will appear.  The 
Status tab will be displayed as the starting point for 
your session, you will notice that the channel icons 
show small padlock symbols.  The padlocks indicate 
that you do not have access to the channel.   
 
The login prompt at the bottom of the screen will 
remember your last login (this is configurable) so you 
just need to click the OK button. Once you have 
successfully logged in the status display will change - 
the padlocks will change and the tabs will be enabled.  The features and channels available to 
you are controlled by your login. 
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5. STATUS 
 
The Status tab provides the foundation for using the recorder.  It is similar to the status screen 
on the recorder. 
 
The Status screen displays the available channels 
using icons that represent the channel type.  If your 
login does not give you access to a channel the 
padlock icon will be shown and you will not be 
able to view that channel. 
 
The (optional) On/Off button will allow you to 
control recording on a specific channel.   Channels 
in the green (on) condition will record when audio 
is received.  Channels with the red (off) condition 
will ignore any audio on the channel. When you 
click the button the display will change to indicate the current setting.  The default condition 
is the “on” setting. 
 
The login prompt allows the user to enter his login value.  You can change users simply by 
entering the new login value and clicking the OK button. 
 
The logout button resets all access setting and puts all channels into the padlock mode. 
 
You are free to login/logout as many times as necessary without ending the JNCS session or 
closing the application. 
 
You will notice that the status tab has a green icon, while the other tabs have red icons.  The 
green icon indicates which tab is active.  If you click on one of the other tabs, its icon will 
become green and the screen will change to reflect the contents of the new active tab. 
 
Click on one of the channel buttons to show a view of the recordings on that channel.  This 
will activate the View tab for that channel.  You can activate the view a number of other way 
as well. There are four ways to enter the View Screen for a channel from the Status Screen: 
 

� Use the Mouse to left click on the channel button; 

� Use the Tab key to highlight the channel of interest and hit the Enter key;  

� Use the number keys to type the channel number. 

� Use the arrow keys to highlight the channel of interest and press Enter key 
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6. VIEW  
 

The View tab displays the recordings for the 
selected channel. The majority of the screen is 
taken up by this list.  You will notice that the last 
recording is highlighted.  You can play back this 
recording by pressing the enter key.  This gives 
you fast access to the latest recording. 

(We call this Instant Recall; if you do it right it 
takes two keystrokes from the Status tab.) 

You can scroll the selection by using the arrow 
keys or the page up/down keys.  When you get to 
the top of the list the software will ask the recorder unit for the previous audio data.  You can use 
the arrow up and page up keys to the scroll the list backwards in time.  As you do this, the 
scrollbar on the side of the list will change to reflect the amount of data currently displayed. 

(The scroll bar covers only the loaded data; use the page up to get older data from the recorder.) 

The system assigns a unique Event Number to each recording for your convenience.  The Event 
Number is listed first, followed by the Start Date, Start Time and Duration of each recording.   
 
The "CC" column contains a "C" to indicate that a recording is longer than 1 hour.  If a recording 
reaches the one-hour duration, the DVR starts a new recording with a new time stamp.  No audio 
data is lost.  This is a safety feature to prevent run away recordings that could waste space. If a 
channel is full of these continued recordings, some adjustment in the settings might be necessary.  
In addition, a one-hour chunk of audio is easily handled by other Windows applications. 
 
The Mark column indicates recordings that have been tagged for some special purpose.  Such 
recordings will have the letter "M" in this column. 
 
The Note column will display the first 20 characters of the note attached to the recording. 
 
The list is scrollable and you can use the up/down arrow keys or the page up/down keys to move 
the list up and down.  The Home key will jump to the top of the current list - it might also load 
older data.  You might need to jump to the top many times to see all of the recordings stored on 
the recorder.  The End key will jump to the last recording. 
 
If a recording has "??:??:??" instead of a duration, don't worry, it just means that the recording is 
still under way and is still growing. 
 
If you want to listen to a particular recording, move the blue highlight bar to the recording of 
interest and hit the Enter key.  You can also double click on the recording using the mouse.  
Either of these actions will bring up the JEI Player.  The player will be covered in the next 
section.  
 
The Refresh button will repopulate the list with the latest recordings.  Sometimes the recorder is 
getting so much traffic that the recordings roll up the screen at an aggressive rate.  This is fairly 
distracting when you are just trying to check older recordings.  The refresh button is equivalent to 
jumping back to the Status tab and choosing the same channel again. 
 
The Export  button makes a copy of the recording and any attached notes on the local hard drive.  
These files are stored in the JEIEXPORT directory on your C: Drive.  From there you can email 
the files, or burn them to CD/DVD, or transfer them to a portable player like the iPod. 
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Caution: DO NOT rename or Delete this subdirectory.  JEI Client program will not 
do any file maintenance in this subdirectory. Periodically delete the audio files from 
this subdirectory to avoid the risk of filling up your local drive.   

 
 
The Note button will call up a small text editor.  If the recording already has a note, it will be 
displayed in the editor.  If the recording does not have a note, a new blank note will be created.  
Type in any text you want.  The editor also supports cut-and-paste from other applications.  
Although you can enter many lines of text, only the first 20 characters will appear in the note 
column.  You might want to put the really important stuff first, like a police report number or the 
caller's name. 
 
You can return to the Status tab by pressing the Escape key until Status appears.  
 

7. PLAYBACK CONTROLS 
 
The JEI Player offers many features to control the playing back of a recording.  You will notice that 
the clocks on the player are "Real" clocks - they represent the times that the audio was recorded - not 
just a simple run-length timer.  When the player opens, it will start playback. 

 

 

 
 

 

At any time during playback, a portion of the original audio file can be selected as a segment for 
repeated playback – called a Subset.  

• Click the mouse or press 1 on the subset control when the playback reaches the starting 
point of the playback portion you wish to separate.  The number “2” will appear on the 
circular digital display.   

• Click the mouse or press 2 on the subset control again when the playback reaches the end 
point of the playback portion you’ve separated.  The number “3” will appear. 

Playback 
Time 
Clock 

Time Progress Bar Playback Subset 

Subset 
Time 
Interval 

Volume Control 
 (Up/down Arrow Keys) 

Mute 
Control 

Subset 
Control 
(button) 

Full Rewind 
Rewind 
Forward 
Full Forward 
 

Jump to next 
Recording 

Play 
Pause 
Loop 
Stop 

Speed Control  (Keys 9 & 8) 



__________________________________________________________________________ 
Digital Voice Recorder DVR-FS   User Manual       
 - 52 - 

• You have now marked a specific portion of the audio recording for repeated play/study. 

• If you click on the subset control again or press the "3" key, you will reset the subset shown 
on the time progress bar.   

• You can select the loop control to playback any portion of a recording over and over by click 
on the loop symbol or pressing the "5" key.   

• The subset time interval clock shows the start and stop time of the subset selected.  

The player can be closed, at any time by, pressing the Escape key or clicking on the exit button at the 
top right corner.  

The Speed control can be adjusted using the 8 and 9 keys.  It will decrease or increase the playback 
speed.  This is useful if the recording capture many things at the same time and it is difficult to 
separate out the sounds.  Playing slower makes it easier to distinguish the sounds.  Speed control is 
less effective when applied to files of higher sampling frequencies and bit rates. 

All functions can be accessed without a mouse via the keyboard by the items listed below each 
button. 

ENTER Play  7 Jump to End 

ESC Close the player  4 Mute 

, (comma) Pause  ▲ Increase Volume 

5 Loop  ▼ Decrease Volume 

* Stop  9 Increase Speed 

HOME Jump to beginning  8 Decrease Speed 

6 Jump to beginning  0 Next Recording 

◄ Fast Rewind  1 Start a Subset 

► Fast Forward  2 End a Subset 

END Jump to End  3 Clear the Subset 

 

 
8. VIEW ALL 
 

The View All tab is similar to the View tab, but it 
displays a recent list of all channels in 
chronological order.5  This tab is useful when you 
are not sure of the specific channel that contains 
the recording of interest.  Also, this screen is 
useful if an incident involved recordings that were 
captured on many active channels.   
 
Playback, Refresh, and Export all function the 
same as the View tab. 

 
 

                                                 
5 Only most recent recordings are displayed. More recordings may be found in the View Screen for a specific channel. 
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9. SEARCHING 
 
The search tab allows the user to search for 
recordings by any combination of channel, 
date, time, or audio source.  Searches can be 
refined to include or exclude radio, 
microphone or telephone channels. There are 
four modes of searching, use the "MODE" 
button to switch to the next mode. The general 
search locates recordings that started between 
two specified date/times.  The Spanning 
search locates recordings that started before 
and end after a specified time.  The event 
numbers locates specific event numbers.  The 
text search will locate recordings base on the 
attached notations. 
 
The Buttons 
 
All of the search modes us a common set of buttons along the right edge of the Search tab.  
As you use the Mode button to change from one search mode to the next, these buttons will 
remain on the screen. 
 
The Search button initiates the search process.  Each time the search is engaged the results list will be 
cleared and repopulated with recordings that match the search criteria.    If no recordings match your 
search criteria, which could happen if your date range is too far in the past, a message will let you 
know that no records were found. 
 
The Clear All button erases the search results list, empties (or resets) all the search criteria fields and 
resets the checkboxes to the default state.  Think of it as the OOPS button. 
 
The Clear Row Button removes the selected row from the search results list; this can be used to fine-
tune the list before printing a report or making a playback collection for external recording. 
 
The Mode Button switches to the next search mode.  The modes are General, Spanning, Event, and 
Text.  Specifics of each mode will be covered in the next section. 
  
The Print button prints a report of the entire search results list.  A printer must be attached to the 
printer port on the back of the Recorder for this feature to function.  Printing is restricted to 
Supervisor level access.  If your access level is not high enough, the print button will never become 
enabled. 
 
The Export File button will make copies of the selected files and place them in the “jeiexport” folder.  
 
The Note button will open the note editor.  When you are done editing the note simply close the edit 
window – the note will be saved automatically. 
 
The General Search 
 
The channel field allows you to specify a particular channel (1) or a list of channels (1,3,5) or a range 
of channels (2-6).  Type in a value and use the tab key to advance to the next field. The search will be 
confined to the channels listed in the field. 
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The “Marked” search options allow a user to search based on the Marker flag on the View tab.  The 
user can narrow a search to include just the recordings that are marked, the recordings that are not 
marked, or choose the ALL option to ignore the marker status of recordings 
 
The Date and Time fields allow users to specify a starting date and time and an ending date and time.  
The recordings listed will only be the records that are between the two date/times.  The user can skip 
entering the starting date/time to get the recordings that occurred before the end date/time.  The user 
can skip entering the ending date/time to get the recording that occurred after the starting time.  The 
time fields are optional and do not have to be entered in which case the date/time will not be a factor 
in the search process. 
 
The Inputs selectors allow a user to search for records that come from a particular type of input 
source.  The default input is “All” which really tells the search not to worry about the input source.  
Any combination of Radio, Mic, and Phone may be selected.  The search results will be filtered to 
include only records that match one of the checked inputs. 
 
The Spanning Search 
 
The Spanning search is really more intuitive; it works much more like a brain works.  Specify a date 
and time of interest and time period.  The search results will bring back the recordings that were 
actually recording at the specified time.   
 
The channel field will specifies a particular channel (1) or a list of channel numbers (1,3,5) or a range 
of channels (2-6).  The search will be confined to the channels listed in the field.  If you leave the 
channel field blank all channels will be included in the search. 
 
The Date and Time fields allow users to specify a date and time of interest. Since the Spanning 
Search is a precision search, all of the date/time fields must be entered.  
 
The time span selectors allow you to set the tolerance of the search.  If you select the 10-minute 
option, the search will find recordings that start or end within 10 minutes of the specified time. 
 
The input selectors (Radio, Mic, and Phone) allow a user to restrict the search results to recordings 
that come from the specified input sources.   
 
The Marked checkbox is a special case, if it contains a check mark, the search will find ONLY the 
recordings that have been marked.  The unmarked recordings will not appear in the search results. 
 
The Event Search 
 
Once the Event search is displayed the event number field will automatically be active and ready to 
accept your search criteria.  You can enter either entire event numbers or partial event numbers.  
When entering partial event numbers the asterisk (*) can be used to denote a partial search.  The use 
of the asterisk is optional.  This is a precision search, it is easy to make a typo in the event number 
field. Don’t get discouraged – check your event number and just try the search again. 
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The Text Search 
 
Once the Event search is displayed the event number field will automatically be active and ready to 
accept your search criteria.  You can enter the text you need to find.  The notes for all recordings will 
be examined and if your search text appears in the note the recording will be added to the search 
results.  The text search looks for the exact phrase that you enter in the field. For example, if you have 
the following information on the recorder: 
 

Recordings 
Event # Note:  
00105242006163243 123 West-Any St 
00105242006164437 321 West Any St 
00105242006172266 123 East Any St 

 
Search criteria of "Any St" would return all three of these recordings.  A search of "123" would find 
the first and third recordings.  A search of "West Any" would only find the second recording.  The 
first record is not found because the hyphen in the first note does not match the search criteria. It is a 
good idea to keep the search phrase as short as possible to generate the most matches.  However, 
searching for common words is not really a good idea either.  A search for "the" is likely to bring 
back more recordings that necessary.  It may take a couple of attempts to get a handle on good search 
phrases for your organization. 
 
The Results 
 
Once you have entered the search criteria and started the search, the system will create a list of 
matching recording.  This might take several minutes if the recorder has been running for a long time 
and has stored a lot of recordings.  
 
The Clear Row, Note and Print buttons will become enabled, if any recordings are listed in the results 
grid. 
 
The search results list operates just like the View tab in regards to navigation, selection and playback.  
Simply highlight a recording and press Enter to open the JEI player. 
 
 
10. ARCHIVE: 

 
The JEI Network Client allows the Remote access of the recorded audio files from the SATA 
Archive.  To access the Data from Archival device Click on the Archive button.  You will be 
presented with the Archive Search features.  
 
You will notice that the Search tab and the Archive Search tab look almost identical.  In fact, they are 
nearly identical in operation as well. All of the controls and features are the same on both tabs.  Refer 
back to the previous section. 
 
The Archive search differs in that it can adjust for the absence of the archive drive.  If you get a 
message that the archive is missing or search results consistently return no results, the archive drive 
may have been removed from the recorder.  
 



__________________________________________________________________________ 
Digital Voice Recorder DVR-FS   User Manual       
 - 56 - 

 
 
 

LIMITED WARRANTY 
 
 
This product is warranted by J.E.I. to the original purchaser to be free from 
defects in material and workmanship under normal use for a period of one year 
from the date of purchase.  During the warranty period, the product will be 
repaired or replaced (with the same or similar model) at our option, without 
charge for either parts or labor.  The warranty will not apply to this product if it 
has been misused, abused or altered. 

 
Some states do not allow limitations on how long or implied warranty lasts or the 
exclusion or limitation of incidental or consequential damages, so the above 
limitations or exclusion may not apply to you.  This warranty gives you specific 
legal rights, and you may also have other rights, which vary from state to state. 
 
 
 
 
 

 

 
3087 Alhambra Drive 

Cameron Park,  CA  95682 
(530) 677-3210 

Fax (530) 677-4714 
Web site: www.jei-inc.com 

 
 

EXCEPT TO THE EXTENT PROHIBITED BY APPLICABLE LAW, ALL IMPLIED 
WARRANTIES MADE BY J.E.I. IN CONNECTION WITH THIS PRODUCT, INCLUDING 
THE WARRANTY OF MERCHANTABILITY, ARE LIMITED IN DURATION TO A PERIOD 
OF ONE YEAR FROM DATE OF ORIGINAL PURCHASE.  NO WARRANTIES, WHETHER 
EXPRESS OR IMPLIED INCLUDING SAID WARRANTY OF MERCHANTABILITY, SHALL 
APPLY TO THIS PRODUCT AFTER SAID PERIOD.  SHOULD THIS PRODUCT PROVE 
DEFECTIVE IN WORKMANSHIP OR MATERIAL, THE CONSUMER’S SOLE REMEDY 
SHALL BE SUCH REPAIR OR REPLACEMENT AS IS HEREINABOVE EXPRESSLY 
PROVIDED; AND UNDER NO CIRCUMSTANCES SHALL J.E.I. BE LIABLE FOR ANY 
LOSS OR DAMAGE, DIRECT OR CONSEQUENTIAL, ARISING OUT OF THE USE OF, 
OR INABILITY TO USE, THIS PRODUCT. 
 


